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Preface

Purpose of this manual

This manual describes Fujitsu ETERNUS Storage Systems Monitoring Pack, a management pack to
monitor Fujitsu ETERNUS storage systems using Microsoft System Center 2012 Operations Manager
and Microsoft System Center 2012 Virtual Machine Manager.

Reader of this manual

This manual is intended for system administrators who monitor Fujitsu ETERNUS storage systems
using Microsoft System Center 2012 Operations Manager and Microsoft System Center 2012 Virtual
Machine Manager.

Organization of this manual
This manual consists of chapter 1 through appendix B and contains the following information.
Overview
The overview of the functions of this product is described.
Setting up and Deleting
How to install and set up this product is described.

Operation
The operation procedure to use this product is described.

Messages
The messages output in using this product and troubleshooting when any trouble occurs are
described.

Configuration File
The configuration file to use this product is described.

Notes on notation

® Microsoft(R) Windows Server(R) 2003, Standard Edition, Microsoft(R) Windows Server(R) 2003,
and Enterprise Edition are abbreviated as "Windows Server 2003".

® Microsoft(R) Windows Server(R) 2003 R2, Standard Edition, Microsoft(R) Windows Server(R)
2003 R2 and Enterprise Edition are abbreviated as "Windows Server 2003 R2".

® Microsoft(R) Windows Server(R) 2008 Standard, Microsoft(R) Windows Server(R) 2008 Enterprise
and Microsoft(R) Windows Server(R) 2008 Datacenter are abbreviated as "Windows Server 2008".

® Microsoft(R) Windows Server(R) 2008 R2 Standard, Microsoft(R) Windows Server(R) 2008 R2
Enterprise and Microsoft(R) Windows Server(R) 2008 R2 Datacenter are abbreviated as "Windows
Server 2008 R2".

® Microsoft(R) Windows Server(R) 2012 Standard and Microsoft(R) Windows Server(R) 2012
Datacenter are abbreviated as "Windows Server 2012".

® ETERNUS SF Storage Cruiser is abbreviated as "ESC" or "Storage Cruiser".
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Microsoft(R) System Center 2012 Operations Manager is abbreviated as "SCOM".
VMware(R) vCenter Server is abbreviated as "vCenter Server" or "vCenter".

Java Runtime Environment is abbreviated as "JRE".
Microsoft(R) System Center 2012 Virtual Machine Manager is abbreviated as "SCVMM".

ETERNUS SF Express / ETERNUS SF Storage Cruiser / ETERNUS SF AdvancedCopy Manager
Installation and Setup Guide are abbreviated as "ETERNUS SF Installation and Setup Guide".

Export Administration Regulation Declaration

This document may contain specific technologies that are covered by International Exchange and
International Trade Control Laws. In the event that such technology is contained, when exporting or
providing the document to non-residents, authorization based on the relevant laws is required.

Trademark

® Microsoft Windows, Windows Vista, Windows Server or other Microsoft product names are
registered trademarks or trademarks of Microsoft Corporation in the United States and other
countries.

® VMware, VMware logo, Virtual SMP and VMotion are registered trademarks or trademarks of
VMware, Inc in the United States or other countries.

® All the other company or product names are trademarks or registered trademarks of their
respective owners.

Notice

® No part of this manual may be reproduced without permission.
® This manual is subject to change without advance notice.

High Risk Activity

The Customer acknowledges and agrees that the Product is designed, developed and manufactured
as contemplated for general use, including without limitation, general office use, personal use,
household use, and ordinary industrial use, but is not designed, developed and manufactured as
contemplated for use accompanying fatal risks or dangers that, unless extremely high safety is
secured, could lead directly to death, personal injury, severe physical damage or other loss
(hereinafter "High Safety Required Use"), including without limitation, nuclear reaction control in
nuclear facility, aircraft flight control, air traffic control, mass transport control, medical life support
system, missile launch control in weapon system. The Customer, shall not use the Product without
securing the sufficient safety required for the High Safety Required Use. In addition, Fujitsu (or other
affiliate's name) shall not be liable against the Customer and/or any third party for any claims or
damages arising in connection with the High Safety Required Use of the Product.
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Chapter 1 Overview

This chapter describes the overview of Fujitsu ETERNUS Storage Systems Monitoring Pack and
ETERNUS Information Provider.
ETERNUS Information Provider must be installed in the previous version of ETERNUS SF Storage
Cruiser V15.X.
In the version of ETERNUS SF Storage Cruiser V16.0 or later, the installation of ETERNUS
Information Provider is not required because the function of ETERNUS Information Provider is
included in the ETERNUS SF Storage Cruiser.

1.1 Fujitsu ETERNUS Storage Systems
Monitoring Pack

Fujitsu ETERNUS Storage Systems Monitoring Pack is a management pack that is imported into
Microsoft(R) System Center Operations Manager 2007 R2 (hereinafter referred to as SCOM), making
it possible to monitor ETERNUS disk arrays.

The operations management server for ETERNUS SF Storage Cruiser (hereinafter referred to as
ESC) being monitored by SCOM, the following can be monitored:

® Event monitoring of ETERNUS disk arrays managed by ESC Manager for Windows

® Life-or-death monitoring of ESC Manager services for Windows

Also, Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO is a Management Pack that monitors the
ETERNUS Disk storage system on SCOM and SCVMM to enable utilization of the PRO (Performance and
Resource Optimization) features.

For more information on the PRO features, refer to the SCOM and SCVMM manuals.
Note: ESC is software sold separately by Fujitsu.

The ETERNUS Information Provider is not required for ETERNUS SF Storage Cruiser V16.0 or later.
Use Fujitsu ETERNUS Storage Systems Monitoring Pack V16.0 for ETERNUS SF Storage Cruiser
V16.0 or later.

Use Fujitsu ETERNUS Storage Systems Monitoring Pack V15.1 for ETERNUS SF Storage Cruiser
V15.X or earlier.

When you update ETERNUS SF Storage Cruiser V16.0 or later, you should set up Fujitsu ETERNUS
Storage Systems Monitoring Pack V16.0.
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1.11 System Configuration

FUJITSU ETERNUS Storage Systems Monitoring Pack and Fujitsu ETERNUS Storage Systems
Monitoring Pack for PRO obtain the information on ETERNUS disk arrays using ESC (sold separately)
to monitor them.

The following is a configuration example of monitoring ETERNUS Disk storage systems using Fujitsu ETERNUS

Storage Systems Monitoring Pack and Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO.
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Fig. 1.1.1 System configuration example
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*ETERNUS SF Storage Cruiser Standard Edition license is required to be purchased.
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1.1.2 Required Environment

This chapter describes the requirements needed to use Fujitsu ETERNUS Storage Systems
Monitoring Pack.

1.1.2.1 Hardware Requirements
The following hardware devices are required to use Fujitsu ETERNUS Storage Systems Monitoring
Pack.

1) Requirements for SCOM management server
Please refer to the document for SCOM for details.

2) Requirements for SCOM monitored server
An ESC operations management server is handled as SCOM monitored server.
® Please refer to the document for SCOM for details of a SCOM agent server.
® Please refer to "1.2.2.1 Hardware Requirements" for details of an ESC operations
management server.

1.1.2.2 Software Requirements
The software requirements to use Fujitsu ETERNUS Storage Systems Monitoring Pack are as
follows.

1) Requirements for SCOM management server
Please refer to the document for SCOM for details.

2) Requirements for SCOM monitored server
An ESC operations management server is handled as SCOM monitored server.
® Please refer to the document for SCOM for details of a SCOM agent server.
® Please referto "1.2.2.2 Software Requirements"” for details of an ESC operations management
server.
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1.2 ETERNUS Information Provider

This is a description of ETERNUS Information Provider.

ETERNUS Information Provider is software that provides the device information for Fujitsu
ETERNUS storage systems on the request of Management Pack.

ETERNUS Information Provider must be installed in the previous version of V15.X of ETERNUS SF
Storage Cruiser.

In the version of ETERNUS SF Storage Cruiser V16.0 or later, the installation of ETERNUS
Information Provider is not required, because the function of ETERNUS Information Provider is
included in the ETERNUS SF Storage Cruiser.

1.2.1 System Configuration

Please refer to "1.1.1 System Configuration" for a system configuration example.

1.2.2 Required Environment for ETERNUS Information Provider

The following are descriptions of the requirements needed to use ETERNUS Information Provider.

1.2.2.1 Hardware Requirements
To use this software, the following hardware devices are required.

Supported server Requirement

Operations management server 1G byte or more of memory

Storage system Remark
ETERNUS2000 model 50/100/200 (*2) (*1)

ETERNUS4000 series (*2)
ETERNUSB8000 series (*2)
ETERNUS DX series

(*1): Excluding SAS model
(*2): Unsupported for ETERNUS SF Storage Cruiser V16.0 or later.

1.2.2.2  Software Requirements

Basic software
Check if this software is installed in any of the following system environments.

Operating system Remark

Microsoft(R) Windows Server(R) 2003 (x86/x64) (*1)

Microsoft(R) Windows Server(R) 2003 R2 (x86/x64) (*1)
-5-
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Microsoft(R) Windows Server(R) 2008 (x86 (*1) /x64)

Microsoft(R) Windows Server(R) 2008 R2

Microsoft(R) Windows Server(R) 2012

(*1): Unsupported for ETERNUS SF Storage Cruiser V16.0 or later.

Required software
To use this software, the following software is required.

Product name Version No. Remark

ETERNUS SF Storage Cruiser 14.2,14.2A, 15.0B, 15.1, 15.2, | (*1)(*2)(*3)
15.2A, 15.3, 15.3A, 16.0

Java Runtime Environment (32 bit version) Version 6 Update 6 or later (*2)(*4)

*1) The most updated urgent patch should be applied.

*2) They should be installed on the Management Server that has ETERNUS Information Provider
installed.

*3) ETERNUS SF Storage Cruiser Standard Edition license is required to be purchased.

*4) Not required if combined with Storage Cruiser V15.0B or later. If combined with Storage Cruiser
V14.2 or V14.2A, obtain what the JRE vendor provides separately.

Note

@ Exclusive software is the same as that for Storage Cruiser.
See

For more information on the exclusive software for Storage Cruiser V14.2 and V14.2A, refer to the
"ETERNUS SF Storage Cruiser V14.2 Installation and Setup Guide".

For more information on the exclusive software for Storage Cruiser V15.0B or later, refer to the
"ETERNUS SF Installation and Setup Guide".
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Ch

apter 2 Setting Up and Deleting

This chapter describes the procedure to set up and delete Fujitsu ETERNUS Storage Systems

Monit

2.1

oring Pack and ETERNUS Information Provider.

Setting Up and Deleting Fujitsu ETERNUS
Storage Systems Monitoring Pack

This chapter describes the procedure to set up and delete Fujitsu ETERNUS Storage Systems

Monit

2.1.
Set

oring Pack.

1 Setting Up
up Fujitsu ETERNUS Storage Systems Monitoring Pack into SCOM.

® Preparation
® Installation Procedure

2.1.1.1 Preparation
Store the file of Fujitsu ETERNUS Storage Monitoring Pack
(Fujitsu.Storage.Systems.ETERNUS.mp) in any working directory that can be referred from SCOM

Operations Console.

In this manual, the file stored location is described as follows.

‘ C:\temp\Fujitsu.Storage.Systems.ETERNUS.mp

NOTE :

The ETERNUS Information Provider is not required for ETERNUS SF Storage Cruiser V16.0 or
later.

Use Fujitsu ETERNUS Storage Systems Monitoring Pack V16.0 for ETERNUS SF Storage
Cruiser V16.0 or later.

Use Fujitsu ETERNUS Storage Systems Monitoring Pack V15.1 for ETERNUS SF Storage
Cruiser V15.X or earlier.

When you update ETERNUS SF Storage Cruiser V16.0 or later, you should set up Fujitsu
ETERNUS Storage Systems Monitoring Pack V16.0. You need to delete Fujitsu ETERNUS
Storage Systems Monitoring Pack V15.1 first, therefore set up Fujitsu ETERNUS Storage
Systems Monitoring Pack V16.0.

2.1.1.2 Installation Procedure

1.

Start the Operations Console.

1) Start the SCOM Operations Console to display the Administration view.

2) Select "Management Packs" on the Navigation pane.

3) Click "Import Management Packs" on the Actions pane to open its dialog box.

-7-
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PR Management Packs [_ o[ <]
File Edit View Go Tasks Tools Help
T s _ i, @
Administration ¢ Management Packs (189) » Tasks
4 £ administration 2| ALookfori | EndMow  Clear x @B @
i! Connected Management Groups Name ‘ Yer & Actions ~
4 |2 Device Management T, System Center 2012 Virtual Machine Manager Diagram Yiews EXI ,
é ocnthlananed :13 System Center 2012 Yirtual Machine Manager PRO Service 1.0, ‘_ s
. o 5 Windows Server Operating System Reports 6.0, ) EEER TR
& 55 Windows Server Cluster Disks Monitoring 6.0,
N i :_g Windows Server 2008 R2 Best Practice Analyzer Monitoring 6.0,
:_g Windows Server 2008 Qperating System (Monitoring) 6.0,
- B2 Virtual Machine Manager Overrides 3.0, E_, Import Management Packs...
JE_I Discovery Rules £ System Center 2012 Wirtual Machine Manager PRO Diagnostics 3.0,
7_.;1‘4 NEnvorkiD evices Yirtual Machine Manager PRO W2 Hyper' Host Performance 3.0,
'Et’ Metwork Devices Pending Managemert: =3 system Center 2012 Yirtual Machine Manager Reports 3.0,
4 -] Notifications T B4 System Center 2012 Yirtual Machine Manager Monitaring 3.0,
|= Channels 55 System Center 2012 irtual Machine Manager Discovery 30
;Ay Subscribers :'E “irtual Machine Manager Library 3.0,
,j Subscriptions System Center Virtual Machine Manager 2008 R2 PRO Library 30
4 g Product Connedtors “irtual Machine Manager PRO W2 Library 3.0,
L Internal Connectors LI B4 Virtual Machine Manager PRO Library 3.0,
iy P :'_g Windows Server 2008 Internet Infarmation Services 7 £.0.
= Windowes Senver Internet Information Services 2003 6.0,
-. Monitoring :73 Windows Serwer Internet Information Services Library 6.0,
‘Windows Server 2008 Qperating System (Discovery] &0,
Microsoft.SQLServer Libirany. P 6.3,
S Server Core Library 6.3
:'_5' System MetworkManagement.Reports JPN 7.0,
! Administration B4 Metwork Management Reportts 7.0
Uﬂ My Workepacs :':g Microsoft. SystemCenter.Operationshianager.Reports, 2007 1PN 7.0,
=5 system Center Core Manitoring Reports 7.0,

Ready

o |

:lJ

2. Select Management Packs.

Select [Add]-[Add from disk] in the menu on the "Import Management Packs" dialog box.

F Import Management Packs

Import list -

@ Help

| Mame

| Fffle

| Werzion

= Add = 7 Properties ... X Re

Add From catalog ...

Status details :

Inztall

Cancel |

A

However, when the following dialog box is displayed, select "No".
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Online Catalog Connection Ed |

™% Some of the management packs vou select may have
| ,-'I dependencies that cannaot be located locally.

Wiould wou like o search the online catalog For

these dependencies?

The "Select Management Packs to import" dialog box is opened.

1) Select the file of Fujitsu ETERNUS Storage Systems Monitoring Pack
(Fujitsu.Storage.Systems.ETERNUS.mp).

2) Click "Open".

F select Management Packs to import

U0 |

Organize *  Mew folder

. = Computer = Local Disk (C:) = temp - l‘i]]l Search temp !/2]

= Libraries
3 Docurents
rJ'- Music
=/ Pictures

E Yideos

B Fuiitsu Stora

s ETERNUS.mp 11721

M Computer
% Lacal Disk (1)
J inetpub
. PerfLogs
. Program Files

. Program Files {x86) ]
. ProgramData
. temp

. Users

findrs LI

File narme: IFujitsu.Storage.Systems.ETERNUS.mp

Execute import.
When the following dialog box is displayed, click "Install".
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nport Management Packs

&) Help

Import list : < Add - 57 Properties ... % Remove

| Hame | Version | Release Date | Statuz | EULA |

Statuz details :

Thiz management pack iz ready to import

Tngtall | Gancel

4

It starts to import Management Pack. Wait a few moments for it to be completed.

nport Management Packs ]

Select Management Packs &) Help

Downloading and importing the selected management packs.

| Mame | Version | Status

P [Fujitzu ETERN ora Impotting

Import Status Details :

Imparting

Stop | Gatce| |

4

On completion of import, the following dialog box is displayed. Confirm that the state is
"Imported" and then click "Close".
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nport Management Packs

Select Management Packs @ Help

Downloading and importing the selected management packs

| Hame | Wersion | Statug

Import Status Details :

Confirm import.
Confirm that Fujitsu ETERNUS Storage Systems is displayed in the list of Management Packs
on the Administration view.

PR Management Packs - Fjgp - Operations Manager H=] 3
File View Go Tasks Tools Help
H searchw _ {4, _
Administration < Management Packs (190) > Tasks
4 B Administration ~| Lok for: | Find Mow Clear Xx @ @
), Connected Management Groups . -
=N d s Actions ~
- (=) Do RIS 55 Fujitsu ETERNUS Storage Systems _ .
i Agent Managed [=] Properties
I Agentless M d -
e % System Center 2012 Yirtual Machine Manager PRO Service 1.0,
3l Maragement Servers - . 7% Delete
55 Windows Server Operating System Reports 6.0,
_ﬂ Pending Management - - I o
B8 Windows Server Cluster Disks Monitoring 60, &R Create Management Pack
& UNDGlinuwe Computers .
% Management Packs B Windaws Server 2008 R2 Best Practice Analyzer Monitaring 6.0. 5% Download Management Packs ..
4 [ Netwark Managemert B4 windows Server 2004 Operating System [Monitoring) 60, 5 Import Management Packs..
| e B8, Wirtual Machine Manager Overrides 30
B4 System Center 2012 Virtual Machine Manager PRO Diagnostics 30
2 Netwark Devices :3 i 9 b
o e B R e E4 Wirtual Machine Manager PRO W2 Hyper Host Performance 30
4 = Motifications B5 System Center 2012 Virtual Machine Manager Reports 30,
= Channels System Center 2012 Virtual Machine Manager Monitaring 3.0
A subscribers B5 System Center 2012 Virtual Machine Manager Discovery 30,
_J' Subscriptions B4 Wirtual Machine Manager Library 300
4 & Product Connectors B System Center Wirtual Machine Manager 2006 R2 PRO Library 30,
S5 Internal Connectors LI B2 Wirtual Machine Manager PRO W2 Library 30
o 3 Wirtual Machine Manager PRO Library 3.0,
Discovery Wizard... —
B8 windows Server 2008 Internet Information Services 7 6.0,
P B2 Windows Server Internet Information Services 2003 6.0,
Bl WMonitoring =
B8 windows Server Internet Information Services Librany 6.0,
_# Authoring B3 Windows Server 2008 Operating System [Discavery) 6.0,
Microsoft.5QLServer Librany. JPN 6.3,
{2 Reporting = < R
55 50U Server Core Library 6.3
Administration B4 System.MetworkManagement.Reports.JPN o
E5 Metwork Management Reports .o,
®| myWorkspace -
- T3 Microsoft.SystemCenter. OperationshManager.Reparts, 2007.)PN
v o n i
< |
Ready v

-11-
Copyright 2013-2014 FUJITSU LIMITED



Fujitsu ETERNUS Storage Systems Monitoring Pack Software Release Guide

Note

® After import has been completed, the file of Management Pack
(Fujitsu.Storage.Systems.ETERNUS.mp) will no longer be necessary. Deleting it does not
impose any problem.

® After the "Import Management Packs" dialog box has been closed, it may take some time
before Fujitsu ETERNUS Storage Systems is displayed in the list on the Administration view.
Select [View]-[Refresh] in the menu to confirm it.

2.1.2 Delete
Delete FUJITSU ETERNUS Storage Monitoring Pack.

® Preparation
® Delete Procedure

2.1.2.1 Preparation

When setting up the PRO features Management Packs, you need to delete the PRO features Management
Packs first. Perform "2.2.2 Deletion".

2.1.2.2 Delete Procedure
1. Start the Operations Console.
1) Start the Operations Console of SCOM to display the Administration view.
2) Select [Management Packs] on the Navigation pane.
3) Select "Fujitsu ETERNUS Storage Systems" from the list of Management Packs.
4) Click "Delete" on the Actions pane.
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i Subscribers :Tj System Center 2012 Wirtual Machine Manager Discovery 3.0
_J' Subscriptions :'73 “irtual Machine Manager Library 3.0
4 & Product Connectors B5 System Center wirtual Machine Manager 2008 R2 PRO Library 3.0.
HH Internal Connectors LI B3 wirtual Machine Manager PRO W2 Library 3.0
Discovery Wizard... :E “irtual Machine Manager PRO Library 3.0
5 Windows Server 2008 Internet Information Services 7 6.0
.. Monitoring 3:3 windows Servet Internet Information Services 2003 6.0,
= Windows Server Internet Information Services Library 6.0
55 Windows Server 2008 Operating System (Discovery) 6.0,
:_g' Microsoft.5QLServerlibrany. PN 6.3,
- B SQL Server Core Library 8.3,
" Administration B5 System.MetworkhManagemert.Reports. PR 7.0
{ My Workspace :ZQ Metwork Management Reparts 7.0
o 23 Microsoft.SystemCenter. OperationsManager.Reports, 2007.JPN 7.0
-
ﬁ., b ,,n,I,,L A

Ready

2. Execute Delete.

The following dialog box is displayed.
When "Yes" is selected, Delete is executed, and for "No", Delete is canceled.

Operations Manager |

- Storage Svskems ve

Deleting a Management Pack, might affect the scoping of same
user roles, Are you sure you wank bo delete Fujitsu ETERMNUS

rsion 15,1.0.07

3. Confirm Delete.

Confirm from the list of Management Packs that Fujitsu ETERNUS Storage Systems is deleted.
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PAManagement Packs
le Edit Go Tasks Tools

i Searchw _ } %,

Administration

=]

View

4 08 Administration
s, Connected Management Graups
4 [ Device Management
£‘ﬁ Agent Managed
iy mgentless Managed
‘ﬁ-.l Management Servers
& Pending Management
[d UNIHfLinuy Computers
W Management Packs
4 ,l Metwiork Managemerit
15 piscovery Rules
= Network Devices

H:_‘ Metwork Devices Pending Managemerit

4 -] Notifications
= Channels
_;"-y Subsctibers
“=| Subseriptions
4 & Product Connectors

J Internal Connechors

Discowery Wizard...

. Monitoring
A Authering

; S Reporting
; Administration

_\;‘ My Workspace

Ready

jop - Operati

ns Manager
Help
) Find||| [7] Tasks|| @
< Management Packs (189) > Tasks
| A Look Far: I Find how Clear x @ @
Mame: | Yer 2 Actions A
= System Center 2012 Wirtual Machine Manager Diagram ‘iews 3.0, =1 Properties
=, Svstem Center 2012 Wirtual Machine Manager PRO Service 1.0, _
55 Windows Server Operating System Reparts 6.0, | EEERUETEETE RS
B Windows Server Cluster Disks Manitoring 6.0, £\ Delete
:_3 Windows Server 2008 R2 Best Practice Analyzer Monitoring 6.0, i Create Management Pack
B8 Windows Server 2008 Operating System [Maonitoring) 6.0 B8 Download Management Packs ...
3, wirtual Machine Manager Owerrides 3.0, i, Import Management Packs..
B system Center 2012 Wirtual Machine Manager PRO Diagnostics 3.0.
¥4 Wirtual Marhine Manager PRO W2 Hyper' Host Perfarmance 3.0,
:é System Center 2012 Wirtual Machine Manager Reports 3.0.
Lo ﬂ System Center 2012 Wirtual Machine Manager Monitaring 3.0,
B4 System Center 2012 Virtual Machine Manager Discovery 3.0,
:3 Wirtual Machine Manager Librany 3.0,
7 System Center Wirtual Machine Manager 2008 R2 PRO Library 3.0,
:_3 “irtual Machine Manager PRO W2 Library 3.0,
LI B4 wirtual Machine Manager PRO Library 3.0.
B Windows Server 2008 Internet Information Services 7 6.0
B5 windows Server Internet Information Services 2003 6.0.
:3 Wihdows Server Internet Information Services Library 6.0,
& Windows Server 2008 Operating System [Discovery) 6.0,
Fg Microsoft. 5QLServer.Library JPN 6.3,
5 SOL Server Core Library 6.3,
:_3 System MNetworkManagement,Reports JPN T.0.
5 Mebwark Management Reports 7.0.
T4 Micrasoft. SystemCenter. DperationshManager. Reports.2007.1PH 7.0,
B System Center Core Monitoring Reports
~ i Anr i [
4

Note

® After the Delete operation has been done, it may take some time before "Fujitsu ETERNUS
Storage Systems" disappears from the list on the Administration view. Select
[View]-[Refresh] in the menu to confirm it.
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2.2 Setting Up and Deleting Fujitsu ETERNUS
Storage Systems Monitoring Pack for PRO

This section explains the procedures to set up and delete Fujitsu ETERNUS Storage Systems
Monitoring Pack for PRO.

2.2.1 Setting Up

Set up Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO in SCOM.

® Preparation
® |Installation Procedure

2211 Preparation

Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO file setup procedure needs to be
completed first. Perform "2.1.1 Setting Up".

Store the Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO file
(Fujitsu.Storage.Systems.ETERNUS.PRO.mp) in any working directory that can be referred from the
Operations Console.

In this manual, the file is assumed to be stored in the following directory:

C:\temp\Fujitsu.Storage.Systems.ETERNUS.PRO.mp

NOTE:
® Use Fujitsu ETERNUS Storage Systems Monitoring Pack V16.0 for PRO for ETERNUS SF
Storage Cruiser V16.0 or later

® .Use Fujitsu ETERNUS Storage Systems Monitoring Pack V15.1 for PRO for ETERNUS SF
Storage Cruiser V15.X or earlier

® When you update ETERNUS SF Storage Cruiser V16.0 or later, you should set up Fujitsu
ETERNUS Storage Systems Monitoring Pack V16.0 for PRO. You need to delete Fuijitsu
ETERNUS Storage Systems Monitoring Pack V15.1 for PRO first, therefore set up Fujitsu
ETERNUS Storage Systems Monitoring Pack V16.0 for PRO.

2212 Installation Procedure

1. Starting the Operations Console.
1) Start the SCOM Operations Console to display the Administration view.
2) Select Management Packs on the Navigation pane.
3) Click Import Management Packs on the Actions pane to open its dialog box.
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lanagement Pack: =1 E3
File Edit View Go Tasks Tools Help
Search v _ 5, -
Administration < Management Packs (190)
4 < Administration Al Qookfor: | Eind Now Clear
&, Connected Management Groups Name ~
3 =
4 L_;’Dewce Llahader et 5x, oystem Center 2012 Wirtual Machine Manager Diagram Wiew I A o
. = Properties
Il cer Chlanaced B Fujitsu ETERMUS Storage Systems 15,
& - &= ExportM it Pack...
2, System Cemnter 2012 Virtual Machine Manager PRO Service 1.0, & Beo e
__g Windows Server Operating System Reports 6.0,
55 Windows Server Cluster Disks Manitoring 6.0,
nuters -
B3 Windows Server 2008 R2 Best Practice Anabzer Monitoring 6.0,
W Management Packs _
TN T 4 P E 5 Windows Server 2008 Qperating System [Monitoring) 6.0, 2 Import Management Packs...
JE’ Discovery Rules B, virtual Machine Manager Overrides 3.0,
_._,_ﬁ s Bt ;' System Center 2012 Wirtual Machine Manager PRO Diagnostics 3.0,
CE plebwork Devices Pending Management 2, Wirkual Machine Manager PRO W2 Hypery Host Performance 3.0,
4 J Motifications T :g System Center 2012 Wirtual Machine Manager Reports 3.0,
21 Channels 54 System Center 2012 Wirtual Machine Manager Monitoring EX
£ subscribers 55 System Center 2012 Wirtual Machine Manager Discavery 30,
_J' Subscriptions ,_9 “Wirtual Machine Manager Library 3.0,
4 & Product Cannectors 55 system Center Virtual Machine Manager 2008 R2 PRO Libraty 30,
Ui Internal Connechars LI B4 Wirtual Machine Manager PRO V2 Library 30
o 54 wirtual Machine Manager PRO Library 30,
Discavery wWizard... .
=8 Windows Server 2008 Internet Information Services 7 6.0,
.. Monitoring ::g Windows Server Internet Information Senvices 2003 6.0,
B3 Windows Server Internet Information Services Library 6.0,
# Authoring 55 Windows Server 2008 Operating System [Discovery) 6.0,
b
B5 Microsoft,5QLServer, Library, JPN LR
Ll Reporting - @ R
B3 2L Server Core Library 6.3,
Administration 54 system.MetworkManagement.Reports JPN 7.0
B4 Mebwork Management Reports 7.0,
My Workspace =
B4 Microsoft.SystemCenter. Opetation shdanager.Reparts.2007. Pk
il |
Ready 4

2. Selecting Management Packs.

Select Add > Add from disk from the menu in the Import Management Packs dialog box.

I, Import Management Packs E

@) Help

Import list : I |—} Add ~ 7 Properties ... X Re

| Name | WVerzion | Fflea

Add From catalog ...

Status details :

Inistall Cancel |
.
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However, when the following dialog box is displayed, click No.

Online Catalog Connection ] |

@™ % Some of the management packs you select may have
WY dependencies that cannot be located locally,

Would wou like to search the online catalog For
these dependencies?

The Select Management Packs to import dialog box opens.

1) Select the Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO file
(Fujitsu.Storage.Systems.ETERNUS.PRO.mp).

2) Click Open.

I, Select Management Packs to import

———— |

Y
Organize = Mew folder I 1 I =~ 0 @

= | ] Iﬁ
- Favarites 4‘ 1 - 1 1

. = Computer = Local Disk (C:) = temp - l‘i]]l Search temp !/2]

B Desktop B Fujitsu.Storage, Systems. ETERNUS, PRO.mp
4 Downloads

£l Recent Places

12/20{2012 6...

MP File

- Libraries
3 Documents
rJv- Music
= Pictures

E Wideos

1M Computer
£, Local Disk (C:)
Y] BD-ROM Drive (E:) 5C201201

€W hetwark =] 4] r— | ]
1 |
Fileﬂame:IFujitsu.Storage.Systems.ETERNUS.PRO.mp -l 2 agernent Packs (*np; * |
A
Importing.

When the following dialog box is displayed, click Install.
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nport Management Packs ]

&) Help

Import ligt - “F Add - S Properties ... X Remove

| Hame | Version | Pelease Date | Status | EULA |

J |Fuiitsu ETERN

Statuz details :

Thiz management pack iz ready to impart.

Tngtall | Gancel

4

It starts to import the Management Pack. Wait a few moments for it to be completed.

F Import Management Packs ﬁ

Select Management Packs @) Help

Downloading and importing the selected management packs.

| Name: | Verzion | Status

P [Fujitsu ETERN = . [15.1.00 Imparting

Import Status Details :

Importing

Stop | Catce| |

4

On completion of import, the following dialog box is displayed. Confirm that the state is
"Imported" and then click Close.
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nport Management Packs ]

Select Management Packs

Downloading and importing the selected management packs.

@) Help

| Mame | Version | Status

Import Status Details :

Stop

Confirming import.

Confirm that "Fujitsu ETERNUS Storage Systems PRO" is displayed in the list of Management
Packs on the Administration view.

P& Management Packs - fjgp - Operations Manager [_1O]x]
File View Go Tasks Tools Help
i searchw _ {4, _
Administration < Management Packs (191) > Tasks
4 i} Administration «| Atookfor | Find Now Clear x @ @
s, Connected Management Groups . -
=N 9 s r Actions ~
- (=) Do RIS 55 Fujitsu ETERNUS Storage Systems PRO 15, _ .
& AgentManaged [£2 Properties
BB ohiTEm Lenter Irtual achine Manager Liagram Wit
i Agentless Managed e
- - B3 Fujitsu ETERMUS Storage Systems 15.
3l Maragement Servers - . 7% Delete
TR System Center 2012 Wirtual Machine Manager PRO Service 1.0,
&¥ Pending Management — — .
B4 Windows Server Operating System Reports 6.0, 5% Create Management Pack
B unmlinuxcamputers —
B windows Server Cluster Disks Monitarir 60. W D d Mar t Packs ..
% Management Packs B a = Download Management Pac
4 qg T 5 Windows Server 2008 R2 Best Practice Analyzer Monitaring 6.0, % Import Management Packs...
B Discovery Rules B3 Windows Server 2008 Operating System (Manitoring) 6.0,
:';f e P = Wirtual Machine Manager Overrides 30,
. ¥4 System Center 2012 Virtual Machine Manager PRO Diagnostics 30,
= B8 Wirtual Machine Manager PRO W2 Hyper Host Performarce 3.0,
<1 Channels System Center 2012 Virtual Machine Manager Reports 3.0,
£ subscribers System Center 2012 Wirtual Machine Manager Monitoring 30,
_J' Subscriptions B5 System Center 2012 Wirtual Machine Manager Discovery 300
4 & ProductConnectors B3 wirtual Machine Manager Library 3.0,
2 Internal Connectors =l B Swstem Center Wirtual Machine Manager 2006 R2 PRO Library 30
o B3 virtual Machine Manager PRO V2 Library 3.0,
Discovery Wizard... -
B4 Wirtual Machine Manager PRO Library 3.0,
- 5 Windows Server 2008 Intemet Information Services 7 6.0,
Bl WMonitoring =
B8 windows Server Internet Information Services 2003 6.0,
_# Authoring B Windows Server Internet Information Services Library 6.0,
3 . ‘windows Server 2008 Operating System [Discovery) 6.0,
{2 Reporting =
B8 Microsoth.SQLServer Library JEN 6.3,
! Administration E4 5QL Server Core Library 6.3,
]
B System.MetwarkhManagement,Reports.JPN .0,
®| myWorkspace -
o B4 Metwork Management Reports
v | W it e a0
< |
Ready 4
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Note

e After 1import has been completed, the Management Pack file
(Fujitsu.Storage.Systems. ETERNUS.PRO.mp) will no longer be required.
Deleting it does not impose any problem.

e After the Import Management Packs dialog box has been closed, it may take some
time before "Fujitsu ETERNUS Storage Systems PRO" is displayed in the list on
the Administration view. Select View > Refresh from the menu to confirm it.

2.2.2 Deletion

Delete Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO.

e Preparation
e Deletion Procedure

2221 Preparation

No particular preparation is necessary for deletion.

22272 Deletion Procedure

Delete both the Working Management Pack and PRO features Management Pack. The Working
Management Pack file is automatically created in "3.2.1 Detecting Monitored Servers". If this
Management Pack does not exist, skip the procedures in "Deleting the Working Management Pack"
below:

Deleting the Working Management Pack
1. Starting the Operations Console.
1) Start the Operations Console of SCOM to display the Administration view.
2) Select Management Packs on the Navigation pane.
3) Select "Fujitsu ETERNUS Storage Systems PRO Working" from the list of Management Packs.
4) Click Delete on the Actions pane.
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2.

3.

P& Management Packs - fjgp - Dperations Manager
File Edit View Go Tasks Tools Help
Searchw _ _
Administration 4  Management Packs (192) * Tasks
4 53 Administration | A LookFfor: | Eind Now Clear x @ @
&, Connected Management Groups Name | Were® Actions ~
3 .
d L_;De“'“ema”agem”“ 5, System Center 2012 Virtual Machine Manager Diagram view 3.0 sropet
= = Properties
W ==, Fujitsu ETERMUS Storage Systems PRO Working 10,
T Agentless M d = = Export M 1t Pack..
;] denSasmanage B Fujitsu ETERNUS Starage Systems PRO 151 | & =xport Management Pad
@3l Management Servers -
g T4 Fujitsu ETERNUS Storage Systems 154 /% Delete
&% Pending Management — =
B Syskem Center 2012 %irtual Machine Manager PRO Service 0. 5% Create Management Pack
[J UNIxfLinux Computers .
B4 wWindows Server Operating System Reports .0, = Download Management Packs ...
W Management Packs _ —
. 7.1 e - = windows Server Cluster Disks Monitoring LA i Import Management Packs...
iUJ e windows Server 2008 R2 Best Practice Analhyzer Monitoring 6.0,
] Windows Server 2008 Operating System [Monitarin .0,
2 Metwork Devices P g o) ( gl
i, Metwark Devices Pending Management 5, virtual Machine Manager Qverrides 3.0,
4 -] Motifications T :TA System Center 2012 Wirtual Machine Manager PRO Diagnostics 3.0,
== Channels 53 Wirtual Machine Manager PRC 2 Hypery Host Performance 30,
_;'él Subscribers :TA System Center 2012 Wirtual Machine Manager Reports 3.0,
,J' Subscriptions Swstem Center 2012 Wirtual Machine Managet Monitaring 3.0,
4 & Product Connectors B4 System Center 2012 Yirtual Machine Manager Discovery 30,
L Intemal Connectors 24 virtual Machine Manager Library 3.0,
o 53 System Center Virtual Machine Manager 2008 R2 PRO Library 30,
Discavery Wizard. .. —
Yirtual Machine Manager PRO W2 Library 3.0,
.. Monitoring : Wirtual Machine Manager PRO Library 3.0,
‘windows Server 2008 Internet Information Services 7 8.0,
# Authoring B3 windows Server Internet Information Services 2003 6.0,
B3 Windows Server Internet Information Services Libra .0,
I‘—‘ Reporting _A R
_ B3 Windows Server 2008 Operating System [Discovery) 6.0,
Administration B4 Microsoft.SQLServer Librane)Pr B3,
i 53 SqL Server Core Library %3
\ ) My Workspace f
o = System.MebworkManagement Reports JPR 7.0,
. [ 7
Ready 4

Executing deletion.
The following dialog box is displayed.

Click Yes to proceed or No to cancel.

Operations Manager

Deleting a Management Pack, might affect the scoping of same
| user roles, Are you sure you wank bo delete Fujitsu ETERMNUS
= Storage Systems PRO Working wersion 1.0.0.07

_tes |

Confirming deletion.

Confirm that "Fujitsu ETERNUS Storage Systems PRO Working" is deleted from the list of

Management Packs
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B Management Packs - figp - Operations Manager

[0 Fnd| (2] Tass|| @

File Edit View Go Tasks Tools Help
q Searchv _ L

Administration

4 08 Administration
@, Connected Management Groups
4 [ Device Management
d"-AgEntManaged
[ Agentless Managed
ﬁ] Management Servers
&¥ Pending Management
5 UND#linux Camputers
% ManagementPacks
,i‘q Metwork Management,
4 piscovery Rules
2 Wetwork Devices
‘-_{‘ Metwirk Devices Pending Managemert
2 Motifications

S

S

iz Channels
;‘y Subscribers
“Z] Subscriptions
4 & Product Connectors

Hi Internal Connectors

Discavery \Wizard. ..

._ Monitoring

A Authoring

;‘—‘ Reporting
Administration

_|_I\ My Workspace

Ready

<

Management Packs (191)

m

4, Look for: | ind Maw

Name
53, System Center 2012 Wirtual Machine Manager Diagram Wiew

¥4 Fujitsu ETERNUS Storage Systems PRO

ol

:73 Fujitsu ETERNUS Storage Systems

55 System Center 2012 Yirtual Machine Manager PRO Service
TTA indows Server Operating System Reports

B4 windows Server Cluster Disks Monitoring

B4 ‘Windows Server 2008 R2 Best Practice Analyzer Monitoring
:@ Windows Server 2008 Operating System [Monitoring)

2 Wirtual Machine Manager Ouerrides

55 Syskem Center 2012 Yirtual Machine Manager PRO Diagnostics
:é Wirtual Machine Manager PRO W2 Hypet' Host Performance
53 System Center 2012 Wirtual Machine Manager Reports

B3 System Center 2012 Yirtual Machine Manager Monitoring
System Center 2012 Wirtual Machine Manager Discovery

&3 wvirtual Machine Manager Library

B3 Swstem Center Yirtual Machine Manager 2008 R2 PRO Library
3 “firtual Machine Manager PR V2 Librany

£5 virtual Machine Manager PRO Library

B4 windows Server 2008 Internet Information Services 7

B4 windows Server Internet Information Services 2003

:73 Windows Server Internet Information Services Library

B4 windows Server 2008 Operating System [Discovery]

TTA Microsoft.SQLSenver Librann JPN

B4 SQL Server Core Library

B4 system.MetworkhManagement. Reparts. PN

B4 Metwork Management Reparts

I
T
%

]

[

= E3

Properties

Export Management Pack...
Delete

Create Management Pack
Download Management Packs ..

Import Management Packs...

Deleting the PRO features Management Pack

1. Starting the Operations Console.

1
2)
3)
4)

Select Management Packs on the Navigation pane.
Select "Fujitsu ETERNUS Storage Systems PRO" from the list of Management Packs.
Click Delete on the Actions pane.

Start the Operations Console of SCOM to display the Administration view.
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P& Management Packs - fjgp - Dperations Manager
Fle Edit View Go Tasks Tools Help
Searchw _ ® -
Administration 4  Management Packs (191) * Tasks
a5 Administration | 4 Loak for: I Find Raw Clear x @ @
&, Connected Management Groups Name | Ver Actions ~
3 .
d L_;De“'“ema”agem”“ T System Center 2013 Virtual Machine Manager Diagram Wiews 3.0, sropet
= = Properties
W & Fujitsu ETERNUS Storage Systems PRO 15
T Agentless M d —
) PEIHEEIREEER 5 Fujitsu ETERMUS Storage Systems 15.0
2l Management Servers - X 7% Delete
= System Center 2012 Wirtual Machine Manager PRO Service 10
&% Pending Management — =
00 windaowes Server Operating System Reports 6.0, 5% Create Management Pack
[J UNIxfLinux Computers .
B4 windowes Server Cluster Disks Monitoring 6.0, = Download Management Packs ...
W Management Packs _ —
. 7.1 e - ij windows Server 2008 R2 Best Practice Analyzer Monitoring 6.0, i Import Management Packs...
iUJ e £ Windows Server 2008 Operating System (Monitoring) 6.0,
] B2 Wirtual Machine Manager Cuerrides 30
2 Metwork Devices = 9
8 petwark Devices Pending Managemert 5 System Center 2012 Wirtual Machine Manager PRO Diagnostics 3.0
A J Motifications S :TA Wirtual Machine Manager PRO W2 HyperW Host Performance 3.0,
= Channels B3 System Center 2012 Wirtual Machine Manager Reports 30
_;'él Subscribers :Tj System Center 2012 Wirtual Machine Manager Monitaoring 3.0
,J' Subscriptions B4 System Center 2012 Wirtual Machine Manager Discovery 3.0,
4 & Product Connectors B& wirtual Machine Manager Library 3.0,
L Intemal Connectors LI B4 System Center Virtual Machine Manager 2008 R2 PRO Library 30
N B3 Wirtual Machine Manager PRO W2 Library 3.0,
Discavery Wizard. .. —
5 Wirkual Machine Manager PRO Library 3.0
o BA windows Server 2008 Internet Information Senvices 7 6.0,
.. Manitoring .
23 Windows Server Internet Information Services 2003 6.0,
4 Authoring B8 windows Server Internet Information Services Library 6.0,
B8 Windows Server 2008 Operating System [Discover 6.0,
I‘—‘ Reporting _3 s g System o
_ B3 Microsoft.sQLServerLibrary JPN 6.3,
Administration B4 SOL Server Core Library 6.3,
i B System MebwarkManagement.Reports. PN 7.
\ ) My Workspace —
o £ Mebwork Management Reports EAN
i - ae e %8
Ready 4

2. Executing deletion.
The following dialog box is displayed.

Click Yes to proceed or No to cancel.

erations Manager Ef |

Deleting a Management Pack might affect the scoping of some
| I user roles, Are wou sure you wank to deleke Fujitsu ETERMUS
= Storage Systems PRO version 15.1.0.07

s |

3. Confirming deletion.

Confirm that "Fujitsu ETERNUS Storage Systems PRO" is deleted from the list of Management
Packs.
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anagement Packs - - Dperations Manager
B Manag t Packs - Fjgp - Dperations Manag X
File View Go Tasks Tools Help
Searchw _ | B D Find|| (7] Tasks|| i@
Administration 4  Management Packs (190) * Tasks
a5 Administration | 4 Loak for: | Eind Now Clear x @ @
&, Connected Management Groups .
B, con E P Hame [ver2l pctions
d *jﬂDe"'EEME”agem”‘t System Center 2012 Virtual Machine Manager Diagram View 3.0, sropet
= Properties
m Agent Managed Fujitsu ETERMUS Starage Systems 15,
v Agentless M d = Export M 1t Pack..
L“_J denSasmanage System Center 2012 Wirtual Machine Manager PRO Service 10, & bro P
@3l Management Servers
& : windows Server Operating System Reports g0 /% Delete
&% Pending Management =
windows Server Cluster Disks Monitoring 6.0, 5% Create Management Pack
[d UNLH/Linux Computers
windows Server 2008 R2 Best Practice Analyzer Monitaring B.0. = Download Management Packs ...
W Management Packs
a 7-; e e e e 2 WWindows Server 2008 Operating System [Monitoring) 6.0, & Import Management Packs..
ﬂ e = Wirtual Machine Manager Owerrides 3.0
7_'_:‘ Network Devices System Center 2012 Wirtual Machine Manager PRO Diagnostics 30
8 petwark Devices Pending Management Wirtual Machine Manager PRO W2 Hypery Host Performance 3.0
4 -] Motifications Swstem Center 2012 Wirtual Machine Manager Reports 3.0,
= Channels System Center 2012 Wirtual Machine Manager Monitaring 30
_;"y Subscribers System Center 2012 Wirtual Machine Manager Discowery 3.0
,J' Subscriptions Wirtual Machine Manager Library 3.0,
4 g Product Connectors 5 System Centerirtual Machine Manager 2008 R2 PRO Library 3
44 Internal Connectors B4 Wirtual Machine Manager PRO W2 Library 30
N wirtual Machine Manager PRO Library 3.0,
Discavery Wizard. ..
Windaws Server 2008 Internet Infarmation Senvices 7 6.0,
o B2 Windows Server Internet Information Services 2003 6.0,
._ Manitoring
windows Server Internet Information Services Library 8.0,
4 Authoring vindows Server 2008 Operating System [Discowery) 6.0,
I_, - Microsoft.5GLSenver.Librany. JPN 6.3,
eporting
B QL Server Core Library 6.3,
. Administration B3 System MetworkManagement.Reports. Jpy 70,
i Mebwark hManagement Reports 7.
| 4 My Workspace
- Microsoft SystemCenter.OperationsManager, Reports, 2007.0PN EAN
- ke b e At iin =.._.-..I..__. %8
Ready 4

2.3  Setup for ETERNUS SF Storage Cruiser V15.X

or earlier.

This chapter describes how to set up or uninstall ETERNUS Information Provider.

2.3.1

Setup and uninstallation of ETERNUS Information Provider

2.3.1.1  Setup
ETERNUS Information Provider is set up to the ESC operations management server.

® Preparation
® |nstallation

2.3.1.1.1 Preparation
Please confirm the required software shown in "1.2.2.2 Software Requirements" is installed.

2.3.1.2 Installation
The following are descriptions of the procedure to install ETERNUS Information Provider.

-24 -
Copyright 2013-2014 FUJITSU LIMITED



Fujitsu ETERNUS Storage Systems Monitoring Pack Software Release Guide

2.3.1.2.1 Installation Procedure

1. Run the installer (setup.exe).
See

Download the installer from Fujitsu homepage.
Fujitsu homepage
http://www.fujitsu.com/global/services/computing/storage/eternus/tools/

The installer is started and the [Welcome to the InstallShield Wizard for ETERNUS Information
Provider] screen is displayed.

ETERNUS Information Provider - InstallShield Wizard

Welcome to the Install5hield Wizard for
ETERHUS Information Provider

The InstallShield Wizard will inztall ETERNUS Infarmation
Prosider on pour computer. To continue, click Mest,

< Back

Canicel |

2. Check the contents and click the [Next] button.
3. Sign up for license agreement on the [License Agreement] screen. Check the displayed contents
and if there is no problem, click the [Yes] button.
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ETERNUS Information Provider - InstallShield Wizard

License Agreement -

A

Pleasze read the following icense agreement canefully.

Prezs the PAGE DOWMN key to zee the rest of the agreement,

[T hiz program iz pratected by copyright law and international treaties,
|Inauthaorized reproduction or digtribution of this program, ar any partion of it, may result in

zevere civil and criminal penalties, and will be prozecuted to the masimum extent possible
urder law.

Do you accept all the terms of the preceding Licensze Agreement? 1F pou

Erirt
gelect Mo, the zetup will cloge. Toingtall ETERMNUS Information Prosvider, L‘

vou must accept thiz agreement.
[ Fratall Ehiefd

< Back ez Mo |

4. Specify the function you want to install. Make a check on "Fujitsu ETERNUS Storage Systems
Monitoring Pack" to enable the function compatible with Management Pack.

ETERNUS Information Provider - InstallShield Wizard

]|

Select function F

".._

Select the function ba ingtall.

Check the check box of the function ta install,

[ Wa5A Provider
I [~ Fuptzu ETERMUS Storage Svstems Monitorine Pack: I

[Fratalls hield

< Back | Hest » I Cancel

5. Specify the install destination on the [Choose Destination Location] screen. If you do not change
the install destination folder, click the [Next] button.

If you change, click the [Browse] button.
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ETERNUS Information Provider - InstallShield Wizard

Choose Destination Location

Select folder where setup will install files.,

Setup will install ETERMNUS Information Provider in the fallowing folder.

Toinztall ta this folder, click Mest. Toinstall bo a different folder, click Browse and select
another folder.

~ Destination Falder

C:%Program FileshnETERMUS-55C Browse. .. |

[ stallShield

Cancel |

6. Click the [Reference] button on the [The destination of the place of the installation] screen to
change the install destination folder.

ETERNUS Information Provider - InstallShield Wizard |

The dezignation of the place of the installation

Specify the holder which thiz product iz installed in. | -

It iz inztalled in the following holder. Click on [Reference] button, and chooze holder
when pou ingtall it in another holder,

— Program Directory

Canicel

C:%Program FileshETERMUS-55C Reference |
— Enwironment Directaory
C:4Program FilessETERMUS-55C Reference |
—wlork Directony
C:%Frogram Filesh\ETERMNUS-55C Reference |
| kel Stield

< Back

7. In the case of combination of Storage Cruiser V14.2 or V14.2A, specify the folder in which JRE is
installed on the [Choose Folder] screen to click the [OK] button.
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In the case of combination of Storage Cruiser V15.0B or later, this dialog does not exist.

Example

C:\Program Files\Java\jre6

Choose Folder
Select JRE installed folder.

PR Desktop

F ¥ Metzwerk

= B Administrator

[+ Offentlich

=
m &L, SYSTEM (C2)
& o HD DVD-ROM-Laufwerk (D:)
# o) HD DVD-ROM-Laufiverk (E:)

| ] 4 I Cancel

8. Enter the port number used for the VASA Provider function. If default port number is already being
used for other purposes, specify an available port number.
Since this is not used for the function compatible with this Management Pack, click the Next button.
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ETERNUS Information Provider - InstallShield Wizard I

il

Registration of port number
Fort number iz necesszan for the commurication.

Pleaze input the numbers uzed bo communicate with Agent and Client.

—Service name, Paort number, Recetver

vazapryd |3'I 443 External Paort

esfipeon |3'I 003 Internal Port

[metallEheld

¢ Back

9. Confirm the settings on the File Copy Start screen.

ETERNUS Information Provider - InstallShield Wizard |

Start Copying Files W-h
.

Review settings before copying files.

Setup has enough information to start copying the program files. 1F pou want to resview or

change any settings, click Back. |f vou are satisfied with the zettingz, click MNest to begin
copying files.

Current Settings:
ETERMUS Infarmation Provider -

WASA Provider
Ingtall
Fluiitsu”ETEF{NLIS Storage Swstems Monitorine Pack
niztall.
Program directon
C:%Program FileshETERMUS-55C
E nwiranment directan
C:AProgram FileshETERMUS-55C

B o

[rztallShield

< Back

10. On completion of file copy processing, restart the operations management server and the
installation is finished. To finish the installation process, click the Finish button. ETERNUS
Information Provider Service starts automatically after restarting the server.
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ETERNUS Information Provider - InstallShield Wizard I

Install5hield Wizard Complete

The InstallShield \Wizard has successfully installed ETERMUS
Information Prowvider. Before pou can uze the program, pou
mszt restart wour computer.

% ez, | want bo restart my computer now.

" Mo, | will restart my computer later,

Click. Finigh to complete setup.

+ Back | Finizh I Cancel

2.3.1.3 Uninstalling

The following are descriptions of the procedure to uninstall ETERNUS Information Provider from the
operations management server.

® Uninstallation Procedure

2.3.1.3.1 Uninstallation Procedure
The following is the procedure to uninstall ETERNUS Information Provider.

1. Open the Add/Delete Programs screen from the control panel to select ETERNUS Information
Provider and then click the Change/Delete button.
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& Programs and Features , o e [ |
‘Qk} ~ Control Panel ~ Programs and Features - m I»;Ef—.;-:h m
File Edit View Tools Help
Tasks Uninstall or change a program
View installed updates o A == =
e insialecupdates To uninstall a program, select it from the list and then dick "Uninstall”, "Change”, or "Repair”™.
Get new programs online at
Windows Marketplace = : 'Q
= Organize = 3 Views vz UninstallfChange L2
'!j] Turn Windows features on or off pa "'

Name = = | Publisher
7 ETERNUS Information Provider FUJITSU LIMITED

'L‘f]EI'ERNUS SF Storage Cruiser Manager Fujitsu

2011/08/22
2011/065/22

1. The following Confirmation screen is displayed. Click the OK button.
Confirm Uninstall

Do you want to completely remove the selected application and all of its
features?

2. The following Confirmation screen is displayed. Click the Finish button to finish the uninstallation

process.
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ETERNUS Information Provider - InstallShield Wizard

Maintenance finished.

[nztallShield *izard finished mantenance for ETERMLS
[Hformation Provider.
[t iz neceszary to reboot the computer,

% Hes, | want to restart my cormputer now.

™ Mo, | will restart my computer later.

Click. Finizh o complete setup.

+ Back | Finizh I Eareel

2.3.2 Starting and Stopping the Service

The ETERNUS Information Provider is not required for ETERNUS SF Storage Cruiser V16.0 or later.

2.3.2.1 Starting the Service

Restart the server or start the ETERNUS Information Provider service from the Service screen in
Administration Tools.

2.3.2.2 Stopping the Service

Stop the ETERNUS Information Provider service from the Service screen in Administration Tools.

2.4  Setup for ETERNUS SF Storage Cruiser V16.0
or later.

This chapter describes how to set up or uninstall ETERNUS Information Provider.
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24.1 Setup for ETERNUS SF Manager

For ETERNUS SF V16.0 or later, you need to create and set the Properties file of Fujitsu ETERNUS
Storage Systems Monitoring Pack.
Please set the following settings to the ETERNUS SF Manager.
1) Create and set the Properties file.
By referring to "B.2 Properties file", please create a Properties file.
Please set ON for the values of the Properties file.
2) Reflect Properties file to the ETERNUS SF Manager.
Click [SYSTEM] -> [System Settings] -> [Update in the configuration file] on the GUI operation
screen of ETERNUS SF, and then reflect configuration file to the ESF Manager.
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Chapter 3 Operation

This chapter explains the use of Fujitsu ETERNUS Storage Systems Monitoring Pack and ETERNUS
Information Provider.

3.1 Using Fujitsu ETERNUS Storage Systems
Monitoring Pack

This chapter describes how to monitor ETERNUS disk arrays using Fujitsu ETERNUS Storage
Systems Monitoring Pack.

® Discover Monitored Server

® Screen Structure

3.1.1 Discover Monitored Server
Fujitsu ETERNUS Storage Systems Monitoring Pack monitors the events of ETERNUS disk arrays
by the ESC operations management server being monitored by SCOM.

If a server to be monitored has already been discovered on SCOM, it is automatically monitored by
importing Fujitsu ETERNUS Storage Systems Monitoring Pack.

The server not yet discovered, it needs to be newly discovered as a server to be monitored by SCOM
Agent. For more information on the discovery procedure, refer to the document for SCOM.

Note

® |t may take some time to discover the server.

® In this Management Pack, a part of file of ETERNUS Information Provider is observed and
SCOM Agent acquires the right of access. Therefore, after ETERNUS Information Provider of
the monitored server is uninstalled, a part of file might not be deleted. In this case, please wait
until server information is deleted from State View after uninstallation. Afterwards, please
erase the file if necessary. Please refer to "3.1.2.2 State View" for State View.

® The ETERNUS Information Provider is not required for ETERNUS SF Storage Cruiser V16.0
or later.

3.1.2 Screen Structure
The following are descriptions of the screen structure when Fujitsu ETERNUS Storage Systems
Monitoring Pack is imported.
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3.1.2.1  Monitoring View
The integrated information on ETERNUS disk arrays is displayed on the Monitoring view.
When this Management Pack is installed, the information to be added to the Monitoring view is
described.

™ fjgp - Dperations Manager [_ O] x]
Fle Edit View Go Tasks Tools Help

Monitoring ‘

4 | | Monitaring B =
| Active Alerts . . .
st Bl Vonitoring Overview
=] Distributed Applications -
< Task Status . . . . .
F] UNDLinuscComputers o‘ Required Configuration Tasks: Actions:

£X1] windows Computers wiew all Active Al
In orderfor Operations Managerta manage and monitoryour

network you must complete the following steps: Wiew Computer 5
View Distributed.

4 Agentless Exception Monitoring
4 Application Monitaring

% Required: Enable Notification Channels ViewManagemer

4 (g Fujitsu ETERNUS Starage Systems

% Upgrade to full version

| active Alerts
57| state view Key Conce
<] storage Systems Diagram The Monitoring W
& Monitoring
= Standard Yiews
e State and Alerts: Health Explorer
Forwarder
= Froperties of Aler
> g Microsoft SQL Server =l A Computer Health: Go to Computers
- m Monitaring Scen:
Showe or Hide Views.., ) @i
Ay waming: 1
Mew Views »
Healthy: 0
/@ ! Learn Abo
(&) Maintenance Mode: 0
Bl Monitoring () Unknown Status: 1 Finding Data and
) Using Views
A Authori . -

A Authoring Q§ Distributed Applications Gota Distributed Applications Managing Alerts
{53 Reporting & Critical: 0 Using Maintenan_|
) £\ Waming: 0 Running Tasks

Administration @ Healthy: 2 Tuning Monitarir
(A Maintenance Mode: 0
_!__ My Workspace () Unknown Status 1
- Tliza n,\'_lv
4| | 5
Ready

4

The following folder is added to the tree on the Navigation pane.
® Fujitsu ETERNUS Storage Systems

The following fields are added under the folder.
® Active Alerts
Active Alerts are displayed. For more information, see the "3.1.2.4 Active Alerts" section.
® Storage Systems Diagram

Storage Systems Diagram is displayed. For more information, see the "3.1.2.3 Storage
Systems Diagram" section.
® State View

State View is displayed. For more information, see the "3.1.2.2 State View" section.

3.1.2.2  State View
If you select [Fujitsu ETERNUS Storage Systems]-[State View] on the Navigation pane of the
Monitoring view, the integrated information on ETERNUS disk arrays is displayed in list.
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BA state view - figp - Dperations Manager H[=] E3
Fle Edit View Go Tasks Tools Help

] serch _ § ff Seone 0.

Monitoring ¢ State View (1) * Tasks
@ Monitoring | 4 Lookfar: | Find Mow Clear X B @
| Active Alerts State + | 5)| Mame Path .
== - &l State Actions ~
= Discovered Inventony (@) Healthy Fujitsu ETERNUS Storage Systems WASA-003.5c.fujitsu.esf.cam
%7 Distributed Applications & Start Maintenance Mode...

& Task Status
=25 UNDULinux Computers
25 Windows Computers _
= s Personalize view...
> g Agentless Exception Monitating
& Application Monitoring Tasks -
4 Dataarehouse

S = Entity Properties
4 (g Fujitsu ETERNUS Storage Systems

A A Al & Heslth Explorer
=1 state i L
SLEMEn Navigation -
<. Storage Systems Dizgram
4 (3 Microsoft Audit Callection Serces o] Alert View 3
- 4 Collector 0 | »| [ Diagram View
4 Forwarder P ? :
Al Detail View v RS EventView
L = 12| 5 Network vicinity Dashboard
Show or Hide Views... B syFsliI:::;J ETERNUS Storage Systems properties of Fujitsu ETERNUS Storage e ———
Mews Wiews b HH ¢
Display Mame Fujitsu ETERMUS Storage Systems SR
Full Path Name WS A-003,scf).fujitsu.e st comyFujitsu ETERNUS
.. Monitoring Storage Systems Report Tasks ~
. ) Internal Informat!on CiProgram Files [xBE6NETERMUS-SSCVFISVe sfipivaridb ; Agent Counts by Date, Manageme
A Authering Internal Infarmation -1
3 .
Wersion of management saftware 15,1 #5 Alert Logging Latency
;d Reparting Internal Infarmation CvProgram Files [<86]8ETERMUS-SSCVFISve sfip ; Alerts
2 Principal Mame WaSA-003, 5o fujitsw.esf com »
- Administration ¥ Availability
3
_‘;‘1 My Workspace #5 Configuration Changes
- §2 Data Volume by Management Pacl
| I8 Data Volume by Workfiow and Inst ~
Ready 4

The following is set as the information specific to this Management Pack.

Item Content Remark
State Information that integrates the following state | If the state is not "Healthy", see
information: the "3.1.2.4 Active Alerts"
® Information on the operating state of section to take actions as
services required on the monitored required.
server

® Information on the event trap state of
ETERNUS disk arrays

Name "Fujitsu ETERNUS Storage Systems"

Management Version information for ESC Manager
software version

Note

® This Management Pack handles the information for the discovered server to be monitored as
integrated information for ETERNUS disk arrays.

® In this Management Pack are not defined the fields to be viewed and their display order. As
required, select "Personalize view". For more information on "Personalize view", refer to the
document for SCOM.
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3.1.2.3

Storage Systems Diagram

If you select [Fujitsu ETERNUS Storage Systems]-[Storage Systems Diagram] on the Navigation
pane of the Monitoring view, the integrated information on ETERNUS disk arrays is displayed as an

icon.

After the Management Pack has been imported, only the "Fujitsu ETERNUS Storage Systems
Group" icon is displayed before the monitored server is discovered.

BA storage Systems Diagram - fjgp - Operations Manager

Fle Edit View Go Tasks Tools Help

Searchw _ ifd & f

SRRl -

& @ Layout direction v

Filter by health ¥ Layers v B @ ..

=l E3

Monitoring
4 H Monitoring
] Active slerts
= Discovered Inventory

%2 Distributed Applications

& Task Status

55| UNDLinux Computers

=] windows Computers

> g Agentless Exception Monitoring
& Application Monitoring

4 Dataarehouse

[

| Active Alerts
=7 state View

j Storage Systems Diagram
4 g Microsaft Audit Collection Serices

- L Collector
4 Forwarder

4]

.4 Fujitsu ETERNUS Storage Systems

Show or Hide Wiews...

Mews Wiew b

.. Monitoring
/A Authoring
i‘:' Reporting
" Administration

m My Workspace

Ready

¢ Storage Systems Diagram

-

Fujitsu
ETERNUS St..

1|

Detail View

Fujitsu ETERNUS Storage Systems Group properties of Fujitsu ETERNUS Storage Syste ms

E Group

Display Name  Fujitsu ETERNUS Storage Systems Group

Tasks

Hygle

Maintenance Mode

& Start Maintenance Mode...

Report Tasks

;,‘

;..

ol
v

=B

3..

Agent Counts by Date, Manageme

Alert Logging Latency
Alerts
Availability

Configuration Changes

Data Volume by Management Pacl

% Data Volume by Workflow and Insi|

Event Analysis

Health

Tasks

[0 Entity Properties

& Hesith Explorer

Navigation

| Alert View

< Diagram View

2| Event View

’=’ Metwork Vicinity Dashbeard

| B Performance View

~

Y

If the monitored server is discovered, the "Fujitsu ETERNUS Storage Systems" icon signifying the
integrated information on ETERNUS disk arrays is displayed under "Fujitsu ETERNUS Storage

Systems Group".

For the state of the "Fujitsu ETERNUS Storage Systems" icon, refer to the "3.1.2.2 State View"

section.
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B storage Systems ram - fjgp - Operations Manager |- (O] x|
File Edit View Go Tasks Tools Help

searchy _ | & 2 | @ & 100w < e @ Layout direction ¥ Filter by health ¥ Layers ¥ & ME
Monitoring < Storage Systems Diagram > Tasks
4 [l Monitoring = I | A @
Active Alerts -
_ﬂ @ Maintenance Mode -
| Discovered Inventony
&% Distributed Applications Fujitsu = & Start Maintenance Mode..
b Task Status ETERNU..
| UNDB#/Linux Computers
5| windows Computers
& Agentless Exception Monfoting Tasks =
+ 4 Application Monitoring E ntity Properties
» g DataWarehouse
A Health Explorer
4 (g Fujitsu ETERNUS Storage Systems @
| Active Alerts Navigation ~
£22] tate Views Fujitsu
ETERN =] Aert View
J Storage Systems Diagram

< Diagram View

4 (g MicrosoftAudit Collection Senices -
t2 Event View =
» g Collector A _;‘
» g Forwarder Detail View " | * Network Vicinity Dashboard
» g Microsoft SQL Serer LI ﬂ = Performance View
. P Fuiitsu ETERNUS Slorage Systems properties of Fujilsu ETERNUS Slorage 5] State View
Systems
Tewr wiews b
Display Mame Fujitsu ETERNLIS Storage Systems Report Tasks ~
Internal Information CA\Program Files (=86)\ETERNUS-SSChFISVesfipiwarydb -
., Monitoring Internal Information -1 15 Agent Counts by Date, Manageme
N ‘ “Wersion of management software 151 §~' Alert Logging Latency
_#| Authoring Internal Information CAPragram Files (<G6\ETERNUS-SSCVFISWesfip & e
. Principal Name WASA-003.scfj.fujitsu.est.com s
I = Reporting i Availability
7 ! Administration i—" Configuration Changes
m My Work: i“' Data Volume by Management Paci
\ ly Workspace
i_; Data Volume by Workfiow and Ins
T =| 3B event Analysis -
Ready P

If any error occurs in the integrated information on ETERNUS disk arrays, it is reflected in the "Fujitsu
ETERNUS Storage Systems" icon and the state of "Fujitsu ETERNUS Storage Systems Group" icon.

B storage Systems ram - fjgp - Operations Manager M=

Fle Edit View Go Tasks Tools Help

searchv _ifd @ O | @ & 100w o e @, Layout direction | & Fiter by health w Layers ¥ & B
Monitoring < Storage Systems Diagram > Tasks
4 | Monitoring E I | N 7]
Active Alerts _ .
_ﬂ- Maintenance Mode -~
j Discovered Inventony g
ﬂ Distributed Applications R Start Maintenance Mode...
[ Task Status Fujitsu =
= ETERNU..
5] UNDLinux Computers
=5 windows Computers
» g Agentless Exception Monitoring Tasks ~
> L Application Monitaring B Entity Properties
» g DataWarehouse
& Health Explorer
4 7 Fujitsu ETERNUIS Storage Systems
] active lerts a Navigation -~

27| state view & | ety
ujitsu - Alert View
j Storage Systems Diagram E'I!EFIN
4 {5 Microsoft Audit Collection Sences . [5a Diagram View
s g Collector LI j 2 Event View

-®  Network Vicinity Dashboard

m

g Forwarder

Detail View wll

» g Microsoft SQL Serer LI ﬂ = Performance View
Show or HideWiews B Fujitsu ETERMUS Storage Systems properties of Fujitsu ETERMUS Storage 1% Sate View
Systems
My Wi e b .
Displaw Mame Fujitsu ETERMUS Storage Swstems Report Tasks -~
Internal Information CA\Program Files [x&6\ETERMNUS-SSCYFISVesfipiwarydh =
Bl wonitoring Internal Informsation 1 I8 Agent Counts by Date, Manageme
" . “Wersion of management software 151 i“‘ Alert Logging Latency
_# Authoring Internal Infarmation CAPragram Files [x86]\ETERMUS-S5CWFISYesfip B Aet
= . Principal Mame WASA-003scfifujitsu.esf.com e
| eporting 12 mailabiity
, Administration #5 configuration Changes
45 Data Volume by Management Pacl
g My Workspace
i“' Data Volume by Workfiow and Ins
T = 2 Event Analysis -
Ready 4
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Note

® This Management Pack handles the information on the discovered server to be monitored as
integrated information on ETERNUS disk arrays.

® \When two or more servers are detected, two or more "Fujitsu ETERNUS Storage Systems"
icons are displayed. In this case, you can distinguish the server by referring to [Detail
View]-[Principal Name].

3.1.2.4  Active Alerts
If you select [Fujitsu ETERNUS Storage Systems]-[Active Alerts] on the Navigation pane of the
Monitoring view, a discovered alert is displayed.
For more information on alerts discovered by this Management Pack, refer to the "A.1 Messages
Output by ETERNUS Storage Systems Monitoring Pack" section.

B active Alerts - Figp - Dperations Manager M=l
File Edit View Go Tasks Tools Help
Monitoring < Active Alerts (3) * Tasks
4 W Monitoring a| ' Look For: | Find Mow Clear x [ @
| Active Alerts % ]‘ Path Source ‘/5'| Hame Alert Actions ~

=] Discawered Inventory
22| Distributed &pplications
5 Task Status
=22| LINDHfLin L Camputers
=25 windows Camputers
+ g Agentless Exception Maonitorng
- 5 Application Manitorng
é Datawarehouse
4 | g Fujitsu ETERMUS Storage Systems
| Active Alerts
=it State Wiew
| Storage Systems Diagram
4 (3 Microsoft Audit Collection Senices
> 3 Collector
> 3 Forwarder
> 5 Microsoft 3QL Server

Show or Hide Wiews...

e wiew b

.‘ Monitoring
4 Authoring
;'—‘ Repaorting

"% Administration

T?:\ My Workspace

Ready

4 Severity: Critical (1)
) vasa-003.scfifujitsu... Fujitsu ETERNUS Stara...

4 Severity: Warning (2)
A4 WASA003, 5o fujitsu,..  Fujitsu ETERMUS Stara..,
B WRSA-003,scff fujitsu,.. Fujitsu ETERMUS Stara,.,

Subscription ~ |
. Create.
.. Modify...
< | »
R Tasks ~
Alert Details v
= | Alert Properties
& X Close Alert
A1\ 40001 The event trap was detected. Alert Description IR el
couree: [, Fuitsu ETERNUS Storage "TXA1052, "2012/12/25 SHERET SR
’ " Systems 15:46:00", *Report-ID =7 Entity Properties
Full Path I \U"UASSAG fujit; T. iFugjit: =67 /Threshold valus Heailth Expl
ull Path Mame: sifj fujitsu.esf.comiFujitsu X . 8 Health Explorer
ETERMUS Storage Systems exceed : CMOLICPUO Busy
Rate over 1%"
Alert Rule: . Fujitsu ETERMUS Storage Navigation s
=" Systems Event Warhing
Created: 12/25/2012 6:47:16 PM =| Alert View
< Diagram View
Knowledge: E] wiew additional knowledge.., £2| Event View
8] Network Vicinity Dashboard
Summary
- The event trap was detected, The following are described in [Alert description] J | FRIETTErEE W
x FE Y . -

View or edit the settings of this rul
40001 The event trap was detected
R Start Maintenance Mode...

40001 The event trap was detected
40001 The event trap was detected

&y Overrides b

[ss Persenalize view..

RS

For the discovered alert, confirm the contents of "Alert Description” and "Knowledge" to respond to it.
After responding, select [Tasks pane]-[Close Alert] to close the alert as required.
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However, depending on the alert type, even though the alert is closed, the integrated state does not

turn to "Healthy" automatically. In this case, it is required to take the following procedure to manually

set the state information to "Healthy".

1) After responding to the discovered alert, close all the alerts.
2) Select [Fujitsu ETERNUS Storage Systems]-[State View] on the Navigation pane of the
Monitoring view.
3) Select a row on which error is shown from the list of integrated information on ETERNUS disk
arrays.
4) Open [Tasks Pane]-[Health Explorer].
5) Select a field to which you want to set "Healthy" from "Health Monitor for Fujitsu ETERNUS
Storage Systems".
6) Select [Reset Health] or [Recalculate Health] in the menu.
7) Close Health Explorer.
@ Health Explorer for Fuijitsu ETERNUS Storage Systems
(@) Reset Health 5] Recalculate Health || n itors | G Befresh (=] Properties @) Help © 5 Ouerrides 9
Scope is anly unhealthy child manitars, x i Knowledge | State Change Events (8] |
PR ujitsu ETERMUS Storage Systems [Ohjed) ]
] -Q::)l . ujitsu ETERNUS Storage Systems [Objed) Surnrnary
) onitor (Error]. Fujitsu ETERNUS Storage Systems (Fuiitsu ET _  This manitar observes the event traps.
LE\rentTrapMunitnr[\/\l’aming]-FujitsuETERNLISStnrageiystems[Fujits\l
Causes
When the state of this manitar is unhealthy, some event traps were detected,
Resolutions
When the state of this monitor is unhealthy, please confirm the state of the device
referring to ETERMUS SF Storage Cruiser,
< | » =
Note
® This Management Pack displays only the alerts where the resolution state is "0" in the default

state. As for the other fields to be viewed and their display order, they are not defined in this
Management Pack. As required, select "Personalize View". For more information on
"Personalize View", refer to the document for SCOM.
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3.2 Using Fujitsu ETERNUS Storage Systems
Monitoring Pack for PRO

This chapter explains how to monitor ETERNUS storage arrays using Fujitsu ETERNUS Storage
Systems Monitoring Pack for PRO.

e Detecting Monitored Servers
e Screen Structure

3.2.1 Detecting Monitored Servers

Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO detects servers that have been

previously detected in "3.1.1 Detecting Monitored Servers”, and also detects the servers whose SCVMM
server names are registered.

Register the SCVMM server names using the following procedure:
1) Start the command prompt on the monitored server.
2) Execute the following command to move the location:

*k  For Eternus SF Storage Cruiser V15.X or earlier

‘ > cd <Information Provider program directory>\bin

* For <Information Provider program directory>, specify the Program Directory set in
"'2.3.1.2.1 Installation Procedure”.

*  For Eternus SF Storage Cruiser V16.0 or later

* Download the following command(defreginfo.exe) from Fujitsu homepage in
advance.
Fujitsu homepage

http://www.fujitsu.com/global/services/computing/storage/eternus/tools/
> cd <downloaded directory>

3) Execute the following command to register SCVMM server names:
Refer to "C.1 SCVMM server name registration command" for details.
| > defreginfo.exe -a -F <SCVMM server name> |

Also, the Fujitsu ETERNUS Storage Systems Monitoring Pack for PRO monitor needs to be enabled

by using the following procedures. By enabling the monitor, each feature in "3.2.2.2 PRO State", "3.2.2.3
PRO Alerts", and "3.2.2.4 PRO Tips" Will be enabled.

1. Starting the SCVMM Console.
1) Start the SCVMM Console to display the Fabric view.
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2) SelectVMM Server on the Navigation pane.
3) From the list of VMM servers, select a target VMM server name.
4) Execute Properties from the ribbon, and open the Properties dialog box.

Server Tools Administrator - VFWNETMZBPODD1 sofifuiitsu_est.com - Virtus )=
Home Folder Library Server WMM Server G @

Properties

Properties

Fabric < VMM Servers (1)

- _33 Servers “

| All Hosts Cluster Name Is Active Mode

Agent Status
Bt VFWNEZMZBPOOOL.schifujitsu.esf.col @) Responding

= Library Servers Library, YMM Server
;ﬁ PXE Servers

i— Update Server
5 vCenter Servers

M VMM Server
-4 Networking

Storage

VPWNE7MZEP000 1.scfj.fujitsu.esf.com k4
Status Recent job
Agent status: ‘O, Responding Managed computer job

}& VM d Servi Agent version status: Up-to-date Job status:

s and Services

N Date modified: 11/7/2012 4:59:26 PM

3,) Fabric Compliance

& i Compliance status:

ibra

L v Operational status:

[E] Jobs Last scan:

Settings

-
Ready "

Properties dialog box.

1) Inthe (SCVMM name) Properties dialog box, select PRO Configuration.
2) Select all Monitor check boxes displayed in PRO Monitor Configuration.
3) Click OK.
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& localhost Properties

General PRO Monitor Configuration

PRO Configuration | o

PRO State Monitor Name | MP Name | Severity | Inherit | Maonitor | Remediate

= WMM Server PRO Monitars

Event Trap Monitor (Threshold Exceed)  Fujitsu.Sto... Warning - v Il
Event Trap Monitor (Pocl Warning) Fujitsu.Sto_ Warning - [~ -
Event Trap Manitor (Pool Critical) Fujitsu.5to... Error - [~ -
Event Trap Monitor (Pool Caution) Fujitsu.5to_. Warning - v -

View Script

Refresh |
QK. I Cancel |

A

3.2.2 Screen Structure

This section explains the window configuration when Fujitsu ETERNUS Storage Systems Monitoring

Pack for PRO is imported.

3.2.2.1 Monitoring View

Integrated information on the ETERNUS disk storage system is displayed on the Monitoring view.

This section explains the information to be added to the Monitoring view when this Management

Pack is imported.
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A fjgp - Operations Manager
Fle Edit View Go Tasks Tools Help

Searchw _ {1, 7]

Monitoring <

O]

4 | [H Monitoring a
| Active Alerts . . .
[ Discovered Inwentary !l Monltormg Overview
| Distributed Applications
[ Task status =
] UNDGLinucComputers '0" Required Configuration Tasks: Actions:
£ Wwindows Computers N

e In arderfor Operations Managerta manage and monitoryour
4 Agentless Exception Manitoring netwiark you must complete the following steps: Wiew Computer S

Wien all Active Al

4 Application Monitaring Wiew Distributed .,
> 9 DataWarehouse % Required: Enable Notification Channels Wiew Managemer
g Fujitsu ETERMUS Storage Systems

| Active Alerts

=] state View

.

% Upgrade to full version

Key Conce
. The Monitaring ¥
P
. Standard iews
ﬂPRO Alerts State and Alerts: -
=5 PRO State
» Properties of Aler
| & Computer Health, Goto Camputers
- m Monitaring Scen:
Shows or Hide Yiews.. >4 \z't‘“" .
/) arning;
i EL @) Healthy: 0 L Ab
(A Maintenance Mode: 0 cai q
Bl Monitoring () Unknowm status 1 Finding Data and
) Using Views
#{  Authoriny . -

A 9 Ay Distibuted Applications Goto Distributed applications Managing Alerts
;n Reporting & critical: ] Using Maintensn_|
| £\ Waming: 0 Running Tasks

Administration @ Healthy: 2 Tuning Monitarir
(#) Maintenance Mode: 1]
_!_ My Workspace ) Unknown Status: 1
- Ovnlins AT
4] | b
Ready

v

Add the following folders under the Fujitsu ETERNUS Storage Systems folders added to the
Navigation pane tree in "3.1.2.1 Monitoring View".

® PRO

Add the following fields under the folder.
® PRO Alerts

Displays active alerts related to PRO. Refer to "3.2.2.3 PRO Alerts" for details.
® PRO State

Displays states related to PRO. Refer to "3.2.2.2 PRO State" for details.

3.2.2.2 PRO State

Displays a list of state information related to ETERNUS Disk storage system PRO if Fujitsu ETERNUS
Storage Systems > PRO > PRO State is selected on the Navigation pane of the Monitoring view.
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PR PRO State - figp - Operations Manager !E‘
Fle Edit View Go Tasks Tools Help
Menitoring %  PRO State (1) * Tasks
4 B Monitoring a| L4 Look for: I Find Mo Clear x [ ®
L e el ot State Actions -
5| DiscoveredInventon @ Healthy Fujitsu ETERMUS Starage Systems PRO WASA 103,507 fujitsu.est
=% Distributed Applications &y start Maintenance Mode..
s Task Status
=2 UNDLinux Computers
225 wind ows Computets =
s Personalize view...
4 Agentless Exception Montorng
4 Application Monitoring Tasks ~
a4 DataWarehouse .
—| Entity Properties
4 (g Fujitsu ETERMUS Storage Systems
=] Active Alerts B Health Explorer
D ate s Navigation ~
4| Storage Systems Diagram
‘ ‘éPRO al LI =| Alert View L
| FRO Alerts . | Diagram View
£ pRO tate Detail View " [ Event view
4 (g Mi it Audit Collection Se i = .
g MicrosoitAudit collection servites = | Fujitsu ETERNUS Storage Systems PRO properties of Fujitsu ETERNUS Storage %] Network Vicinity Dashboard
. : Systems PRO X
Show or Hide ‘iews... Performance View
M) Display Mame Fujitsu ETERMUS Storage Systemf PRO B coate View
Full Path Mame WSS 003 scf] fujitsu, esf.comiFujitsu ETERMUS
Storage Systems PRO
Bl Monitoring Whih Server WRAWNETMZBPO00L 5 cfj. fujitsu.esf.com Report Tasks &
S puthorin Mame SWRARNETMZIBPON0 L. scfj. fujitsu.esf.com |F Agent Counts by Date, Manageme
= g Internal Information ChProgram Files (86NETERMUS-S5CWFISY esfiphwaridb 1
) §% Alert Logging Latency
l'_‘ R 5 Internal Information -1
eporting . i
Wersion of management software 15,1 i= Alerts
o T e T Internal Information ChProgram Files (xE6WETERMUS-SSCWFISYesfip ‘F Availability
) Principal Mame WASA-003, 50 fujitsu esf.com 2
_la‘ My Workspace ¥ Configuration Changes
Yid
'r Data Volume by Management Pacl
M ﬂ 'F Data Volume by Workflow and Insl ©
Ready 4
The following is set as the information specific to this Management Pack.
Item Description Remarks
3 3 . 3 n "
State State information below: If the state is not "Healthy",
. " "
e Information on the event trap state refer to3.2.2.3 PRO Alerts",
of ETERNUS Disk storage system | and take action as required.
performance.
Name "Fujitsu ETERNUS Storage Systems PRO".
Management Version information for ESC Manager.

software version

Note

e This Management Pack handles the performance information for the detected
server to be monitored as state information for ETERNUS disk storage systems.

e In this Management Pack, the fields to be viewed and their display order are not
defined. Select "Personalize view" as required. For more information on
"Personalize view", refer to the SCOM manual.
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3.2.2.3 PRO Alerts

If you select Fujitsu ETERNUS Storage Systems > PRO > PRO Alerts on the Navigation pane of the
Monitoring view, a detected alert is displayed.

Refer to "A.1 Messages Output by Fujitsu ETERNUS Storage Systems Monitoring Pack” for details on the alerts
detected by this Management Pack.

FRPRO Alerts - figp - Operations Manager =l
File Edit View Go Tasks Tools Help
] Searchw _ | Overrides¥ _ i ¥l Scope |[ [ Fnd||[[F] Tasks| @ -
Monitoring < PRO Alerts (4) *» Tasks
4 H Manitoring | 4 Look For: I Find Mow Clear X B @
Active Alerts & -
n’. ‘ 5 ]‘ Path Source |’5.'| Name Resalution ayo4 Actions A
il seovereLlven o 4 Severity: Critical (1)
o o - View or edit the settings of this mc|
e e G WASA-003 scfj.fujitsu.esf.com Fujitsu ETERNLL.. ESC storage ewent Mew
= :
[t Task Status 4 Severity: Warning (3) WY start Maintenance Mode..
=28 UMD C e
IR A\ WASA-003scfifujitsuest.eom Fujitsu ETERNU., ESC storage event Hew
=8| windows Computers
= b WASA-003 sofjfujitsu.esf.com Fujitsu ETERMLL.. ESC storage event e
4 Agentless Exception Monitaring
L A WASA-003 sofj.fujitsu.esf.com Fujitsu ETERML.., ESC storage ewent Mew R Overrides b
+ g Application Monitoring %y Cvemides
+ L Data¥varehouse s Personalize view...
4 g Fujitsu ETERMUS Storage Systems
=] Active Mlerts S e
=i State Wiew 1 Create.
| Storage Systems Diagram | Modify..
4 (5 PRO 4 | i
| PRO &lerts : I Tasks ~
o Alert Details v
s| PRO State - | == Alert Properties
Jl | B 7| 2 close lert
A\ ESC storage event Alert Description i Close Ale
Showe ar Hide Wigws... Set Resolution State b
N - Fujitsu ETERMNUS Starage “M EZ010000 TRPE00D turmned to <t Resolubion wtate
» :
. " Systems PRO CALTION [decrease of available = Entity Properties
EUAB‘SA’CF Fujit: . "WFujit capadt” Health Expl
Menitorin . LS TuiEs L e ST comrugitsu . €3 xplorer
.- 9 Full Path Hame: ETERNUS Storage Systems
> . igati A
Afsiens Ewent Trap Manitor [Poal Navigation
Alert Monitor: 2 raut
i_‘ 0 . aution] | Alert View
eporting Created: 1272672012 2:30041 PM
-~ <| Diagram View
{0 Administrati
g ministration t3) Eyent View
_|_:1 My Workspace Knowledge: Wiew additional knowledge... 5% Network Vicinity Dashboard
- Resolutions “<| Performance View
The use capacite tatio of Thih Provisioning Pool exceeded the caution threshold, Please ﬂ A PSP °
Ready 2

Detected alerts are also displayed on the SCVMM Console as the PRO Tips. Refer to "3.2.2.4 PRO Tips"
for details and actions for the alerts.

Note

e This Management Pack displays only the alerts where the resolution state is "0"
in the default state. As for the other fields to be viewed and their display order,
they are not defined in this Management Pack. Select "Personalize view" as
required. For more information on "Personalize view", refer to the SCOM
manual.

3.2.24 PRO Tips

The alerts detected by PRO Alerts are displayed on the SCVMM Console as PRO Tips.
PRO Tips can be displayed as a list using the procedure below:
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1) Start the SCVMM Console to display the Fabric Resources view.

2) Select Servers on the Navigation pane.

3) Execute PRO from the ribbon to open the PRO Tips window.

W Administrator - VFWNEZMZBPOO01 scfi fujitsu esf com - Virtual Machine Manager

Home Folder
<

Create Add Qverviaw
= Resources =

4
Fabric
Resources

Create Add Show Compliance

Fabric < Managed Computers (1)

Compliance Scan Remediate Compliance Update Reassociate Connect N
Properties Agent via RDP ﬁ PRO

l@ _. E} E'.j A, Poviershel

E Jobs

Agent Window

- 3_?_ Servers ‘

D

1 All Hosts MName | Agent Status

| Rale

:,.; Library Servers EB WFWNEZMZBPOO0 1, scfj. fujitsu.esf.com '@ Responding Library, VMM Server

;i PXE Servers

£ Update Server
f] vCenter Servers
_f VMM Server

b - Networking

’ Storage

¥ VMs and Services

3..:... Fabric
—

Settings

Ready

A list of the PRO tips detected is displayed in the PRO Tips window.
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Egrro

=]
PRO (4)
Severity | Source | Tip | State | Created
', localhost ESC storage event Active 12262012 2:29 PM
n localhost ESC storage event Active 12262012 2:30 PM
Bl localhost ESC storage event Active 12/26/2012 2:30 PM
E_ localhost ESC storage event Active 12/26/2012 2:30 PM
W ESC storage event v
., ESC storage event Target Summary
"M EZ010000 TPP£000 turned to CAUTION (decrease of available capacity)” Name: localhost
~ Cause and Resolution
Target type: Virtual Machine Manager Server
The use capacity ratio of Thin Provisioning Pool exceeded the caution threshold.
Plzase confirm the use capacity and the notification threshald of Thin Provisioning
Pool. Please execute the change of the capacdity enhancing or the notification
threshaold if necessary.
[+ Show this window when new PRO Tips are created View PRO Script Implement Dismiss

For the PRO tips detected, check the information outlined in "Cause and Resolution" and take
action accordingly.

After actions have been taken, execute Implement and close PRO tips. The addressed alerts
displayed in "3.2.2.3 PRO Alerts" are also closed.

If Dismiss is executed, the PRO tips can be closed but the addressed alerts displayed in "3.2.2.3 PRO
Alerts" are not closed. If this is the case, action needs to be taken using the following procedure:

1. Close the alert.

1) Start the SCOM Operation Console, and select Fujitsu ETERNUS Storage Systems > PRO >
PRO Alerts on the Navigation pane of the Monitoring view.
2) From the list of PRO Alerts, select an alert to close.

3) Execute Tasks > Close Alert and close the alert.
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BRPRO Alerts - figp - Operations Manager =
File Edit View Go Tasks Tools Help
Monitoring <  PRO Alerts (4) * Tasks
4 H Monitaring 4| LookFor: I Eind Mowe Clear x B @
| Active Alerts ) _
Lo 3 ]‘ Path | Source ‘45‘ MName Resolution Alert Actions ~
£=] DiscoveredInventory 4 Severity: Critical (1)
=2 Distril icati . View or edit the settings of this mc
£ Dl bliteciSnnlications 9 vasa-n03 saifujitsuestoom  Fujitsu ETERNU,. ESC starage event News ¢
= .
EoylErk Saie 4 Severity: Warning (3) | SERMEMETIE LR
22| UNDHLinue Computers )
= D 3 AU WASA-D03 soff fujitsu.esf.com Fujitsu ETERNL... ESC storage event Newy
= Windows Compurbers
A WASAN03, sofffujitsu.esf.com Fujitsu ETERNU... ESC storage event ey
> @ Agentless Exception Monitoring
A0 WASA-D03 seff fujitsu.est.com Fujitsu ETERML... ESC storage event Mewy ¥ Overrides
© g Application Monitoring Ky Ovemidesh
+ 4 DatawWarehouse [ Personalize view...
4 ( q Fujitsu ETERMUS Storage Systems
] Active Alerts Subscription ~ |
2| State Wiew | Create..
Storage Systems Diagram | Modify..
4 (g PRO <« 3
| PRO Alerts I i Tasks ~
| FRO State Alert Details - )
= B R R - - Alert Properties
| | : it T closeaer
A\ ESC storage event Alert Description = Llose Ale
S Set Resolution State »
: Fujitsu ETERMUS Storage "t EEOL0000 TPP#OOD turned to u
Mews View » Source: B systems PRO i
W CAUTION [decrease of available =] entity Properties
:]IIJABSAPEf fujit: f, WFujit: e Health Expl
o X . sifj fujitsu.esf.comiFujitsu B Health Explorer
.‘ Munr(unng Full Path Mame: ETERMUS Storage Systems
PRO L
A i Navigation ~
J Authoring Ewvent Trap Manitor (Pool <
Llert Manitor < Caution
i"' R— 1 = Alert View
eporting Created: 1242642012 2:30:41 PM
- <. Diagram View
.= Administration 3 Event View
; My Workspace Knowledge: =] Wiew additional knowdedge.., ’=J Network Vicinity Dashboard
- Resolutions “ Performance View
The wse canacity ratio of Thin Prowisioning Pool exceeded the caution threshold, Please ﬂ ] caannc -
Ready 4

However, even though the alert is closed, the integrated state does not turn to "Healthy"
automatically. In this case, you need to perform the following procedure to manually set the
state information to "Healthy".

Setting the state information to "Healthy".

1) Select Fujitsu ETERNUS Storage Systems > PRO > PRO State on the Navigation pane of the
Monitoring view.

2) Select a row on which an error is shown from the list of state information on the ETERNUS
Disk storage system.

3) Open Tasks > Health Explorer.

4) On the Health Monitor for Fujitsu ETERNUS Storage Systems PRO, select the field that you
want to set to "Healthy".

5) Execute either Reset Health or Recalculate Health from the menu.

6) Close the Health Explorer.
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ﬂ Health Explorer for Fujitsu ETERNUS Storage Systems PRO

@ Reset Health 3ﬁ BRecalculate Health ? Filter Maonitors T-'. Refresh ] Froperties -Zé.-ﬂelp 1—._3 Overrides -

Health maonitors for Fujitsu ETERNUS Starage Systems PRO
Scope is only unhealthy child monitors. ®  Knowledge | State Change Events (2] |
4 0;9' Entity Health - Fujitsu ETERMUS Storage Systems PRO [Objed) ﬂ

4 -z_:)? Performance - Fujitsu ETERMUS Storage Systems PRO [Objec Resolutions

EventTrap Monitor (Pool Caution) - Fujitsu ETERMUS Stora The use capacity ratio of Thin Provisioning Pool exceeded the caution threshold, Please confirm

1

éﬁ;- EventTrap Monitor (Pool Critical) - Fujitsu ETERMUS Storag the use capacity and the notification threshold of Thin Provisioning Pool. Please execute the
1
1

change of the capacity enhancing or the notification threshold if necessary.
/1 BventTrap Monitor (Pool'Warning) - Fujitsu ETERMUS Star g pacity 9 1y

EventTrap Monitor [Threshold Exceed] - Fujitsu ETERMUS £

3.3 Maintenance of Information

This chapter describes maintenance of Information.

3.3.1 Collecting Maintenance Information for ETERNUS SF
Storage Cruiser

If any trouble occurs or you make inquiries, provide a Fujitsu engineer (SE) with the following
information and data.

@® Phenomenon
@® Occurrence time
@® Repeatability
@® Maintenance data for Storage Cruiser
Collect the analysis data for Management Server (Windows).

See

In the case of Storage Cruiser V14.2 or V14.2A, for analysis data for Management Server

(Windows), refer to "Appendix D Troubleshooting" in the "ETERNUS SF Storage Cruiser V14.2
User's Guide".
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In the case of Storage Cruiser V15.0B or later, for analysis data for Management Server
(Windows), refer to "Appendix B Troubleshooting" in the "ETERNUS SF Storage Cruiser Operation
Guide".

3.3.2 Collecting Maintenance Information for ETERNUS
Information Provider

If any trouble occurs or you make inquiries, provide a Fujitsu engineer (SE) with the following
information and data. In ETERNUS SF Storage Cruiser V16.0 or later, the collection of this information
is not required because the ETERNUS Information Provider is not used.

Phenomenon

Occurrence time

Repeatability

Maintenance data for ETERNUS Information Provider

Collect the following data.

<Environment Directory>\FJSVesfip\etc
<Work Directory>\FJSVesfip\var

<Program Directory>\FJSVesfip\tomcat\conf
<Program Directory>\FJSVesfip\tomcat\logs

O OO0O0
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Appendix A Messages

This chapter describes the messages of Fujitsu ETERNUS Storage Systems Monitoring Pack and
ETERNUS Information Provider.

A.l Messages Output by ETERNUS Storage Systems
Monitoring Pack

The following are descriptions of the messages displayed with alerts in this Management Pack.
Messages are displayed as "Name" of alerts.

A.l1l Message for Service State

11001
Necessary service is not running.

Meaning of the message
The service required to monitor ETERNUS disk arrays is not running on the monitored server.

Content of [Alert Description]
Service name that is not running

System process
The state of the monitored server is taken as "Critical".

Actions by system administrator
Confirm whether the service shown in [Alert Description] is running on the monitored server. If it is

stopped, start it.

Supplementary information
® This alert is automatically closed when the problem is resolved. In addition, the "Critical” state of

the monitored server accompanied with this alert is automatically canceled.

A.l1.2 Event Trap Message

40001
The event trap was detected.
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Meaning of the message
The event trap was detected.

Content of [Alert Description]
"%1", "%2", "%3"
%21: Device name from which the event trap is generated.
%2: Time and date when the event trap was detected by ESC Manager.
%3: Event trap message gained from the device.

System process
The state of the monitored server is changed according to the trap type.

Actions by system administrator
See ESC Client to check the state of the device that generated the event trap.

Supplementary information
® The event trap of the storage device supported by ETERNUS Information Provider is detected.

Please refer to "1.2.2.1 Hardware Requirements"” for the storage device to be detected.

® If a comma is contained in any event trap message, the message is delimited by comma and may
be partially displayed in [Alert Description]. If you want to check the full text of the message, see
[Alert Context]-[Field 7] and more in the Alert Properties section and the partial text delimited by
comma is displayed.

® The detection object is the event trap (Fault level is Warning or Error) generated by storage
device that ESC Manager manages. Please refer to ETERNUS SF Storage Cruiser Event Guide
for details.

® Close this alert manually after resolving the problem. For how to close alerts, see the "3.1.2.4
Active Alerts" section.

® For the procedure to turn the state back to "Healthy" after having resolved the alert cause, refer to
the "3.1.2.4 Active Alerts" section.

® If more than 50 event traps are generated at the same time, alerts are generated for up to the
latest 50 traps. The other traps before 50 are ignored.

A.1.3 Messages Regarding PRO

ESC storage event

Meaning of the message

An ESC storage event has been detected.

Content of [Alert Description]

"op1"

-53-
Copyright 2013-2014 FUJITSU LIMITED



Fujitsu ETERNUS Storage Systems Monitoring Pack Software Release Guide

%1: Event trap message obtained from the device.

System process

The state of the monitored server is changed according to the trap type.

Actions by system administrator
See ESC Client to check the state of the device that generated the event trap.
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Supp lementary information

® The event trap of the storage device supported by ETERNUS Information Provider is detected.
Refer to "1.2.2.1 Hardware Requirements" for information on the storage device to be detected.

e If a comma is contained in any event trap message, the message is delimited by comma and
may be partially displayed in Alert Description. If you want to check the full text of the message,
see Alert Context > Field 7 and more in the Alert Properties section, and the partial text
delimited by the comma is displayed.

® The detection object is the event trap relating to the threshold information generated by the
storage device that ESC Manager manages. Please refer to the "ETERNUS SF Storage Cruiser
Event Guide" for details.

® C(Close this alert manually after resolving the problem. Refer to "3.2.2.4 PRO Tips" for
information on how to close alerts.

e If more than 50 event traps are generated simultaneously, alerts are generated for up to the
latest 50 traps. The other traps after 50 are ignored.
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A.2 Messages Output by ETERNUS Information Provider

This chapter describes the messages output by ETERNUS Information Provider.

A.2.1 Event Log

The following are descriptions of the event logs output by ETERNUS Information Provider. The type
and source of events are "Application” log and "fisvesfip".

Description of message

esfip10001
Provider is started.

Meaning of the message
ETERNUS Information Provider has started.

Level
Information

System process
None

Actions by system administrator
Unnecessary

esfip11001
Provider is not started. (Service initialization failed.)

Meaning of the message
Starting the ETERNUS Information Provider service failed.

Level
Error

System process
The processing is aborted.

Action by system administrator
Collect analysis material and contact any Fujitsu engineer (SE).
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esfip20001
Provider is normally stopped.

Meaning of the message
The ETERNUS Information Provider service has stopped.

Level
Information

System process
None

Action by system administrator
None

esfip00001
Failed to get storage information. (%s1).

Meaning of the message
Obtaining storage information failed.

Level
Error

Meaning of the parameter
%s1: Message that notifies of failure in obtaining storage information. For more information, see the

table below.

System process
None

Action by system administrator
See the table below.

Detailed parameters for esfip00001

Detailed message Failed to decrypt user information.
Cause An internal processing error has occurred.
Action by system If the message is repeatedly displayed, collect analysis material and contact
administrator any Fujitsu engineer (SE).
Detailed message Command not found.
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Cause

ESC is not installed or an unsupported version.

Action by system
administrator

If ESC is not installed, install it. If ESC is installed, check if it is a compatible
version.

Detailed message

Command abnormally ended.

Cause

It failed in the information acquisition from the storage device.

Action by system
administrator

Please confirm the following.

® \Whether other users are logging in the storage device.

® \Whether the storage device is supported with this software.

® \Whether the state of the storage device and the network environment are
normal.

Otherwise, there is a possibility that the storage device is locked by other
operations. Please log out when you use ETERNUSmMgr. When you are
changing the state of the storage device by using ESC (access path setting,
access path inheritance, and applying the device configuration by using
Storage Volume Configuration Navigator, etc), please restart ETERNUS
Information Provider service after completing work.

If this message is output repeatedly after doing the above-mentioned
treatment, collect the data required for troubleshooting, then contact your
Fujitsu systems engineer (SE).

Detailed message

Unable to connect to the manager.

Cause

ESC is not running.

Action by system
administrator

Start ESC.

Detailed message

Internal error.

Cause

An internal error has occurred.

Action by system
administrator

If the message is repeatedly displayed, collect analysis material and contact
any Fujitsu engineer (SE).

Detailed message

EffectiveFunction has invalid value.

Cause

The value of the "EffectiveFunction" field in the configuration file is invalid.

Action by system
administrator

Set a correct value in the "EffectiveFunction” field in the configuration file to
restart the ETERNUS Information Provider service.

Detailed message

EffectiveCapability has invalid value.

Cause

The value of the "EffectiveCapability"” field in the configuration file is invalid.

Action by system
administrator

Set a correct value in the "EffectiveCapability” field in the configuration file to
restart the ETERNUS Information Provider service.
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Appendix B Configuration File

This chapter describes the configuration file.

B.1 Configuration File for ETERNUS Information

Provider

This chapter describes the configuration file for ETERNUS Information Provider.
The directory path and file name of the folder that contains a configuration file are as follows.

Directory path <Environment Directory>\FJSVesfip\etc\conf

File name InformationProvider.conf

The file is in the text file format where each line has the format of "item name=value".

B.1.1 Fields Set in the Configuration File

The fields to be set in the configuration file and their values are described in the following table. When
changing the content in the configuration file, take the following procedure.

1. Stop the ETERNUS Information Provider service.

2. Update the content of the configuration file.

3. Restart the ETERNUS Information Provider service.

Field Value Description of value Remark
type
EffectiveFunction String When enabling the function compatible with

Management Pack, specify
"SCOM_MngPack".

If Fujitsu ETERNUS Storage Systems
Monitoring Pack is enabled by the installer,
SCOM_MngPack" is specified in the default
state.

[Note] For other setting fields than the above mentioned, they are internal parameters. Therefore, do
not change the values.

B.2 Properties File

This chapter describes the Properties file for Fujitsu ETERNUS Storage Systems Monitoring
Pack that is setting to the ETERNUS SF Manager.
The directory path and file name of the folder that contains a Properties file are as follows.
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Directory path <Environment
Directory>\ESC\Manager\etc\opt\FJSVssmgr\current\properties
File name deviceevent_mspack.properties

The file is in the text file format where each line has the format of "item name=value".

B.2.1 Fields Set in the Properties File

The fields to be set in the properties file and their values are described in the following table. When
changing the content in the properties file, take the following procedure.

1. Update the content of the properties file.
2. Display the GUI screen of ETERNUS SF.
3. Click [System] -> [System Settings] -> [Update in the configuration file]

Field

Description of value Remark

com.fujitsu.storagesoft.opt.deviceev | ON: when you want to monitor

ent.mspack

OFF: otherwise
Default value is OFF

e.x

com.fujitsu.storagesoft.opt.deviceevent.mspack=0ON
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Appendix C  Command References

C.1

Name
defreginfo

Format

defreginfo
defreginfo
defreginfo

SCVMM Server Name Registration Command
(defreginfo)

-a -F FQDN
-d
-

Meaning of the message
Adds, changes, deletes, and displays the SCVMM server FQDN.

Operand
-F

Specifies the SCVMM server FQDN.

Adds the SCVMM server FQDN. If the specified FQDN already exists, it will be changed.
Displays the SCVMM server FQDN after it was added and changed.
[Display format]
Registered value: FQDN

Deletes the SCVMM server FQDN. If no FQDN has been registered, an error will occur.

Displays the SCVMM server FQDN.
[Display format]
Registered value: FQDN
*If no FQDN has been registered, the FQDN will be an empty character.

Note

Execute this command as a user with Administrator privileges.

C.2

Messages Output by the Command

This chapter describes the messages displayed in the Command Prompt window when the
defreginfo command is executed.

reginfo1001
parameter error
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Meaning of the message
There is an error with the parameter.

Type
Error

Treatment
Specify a correct parameter, and execute the command again.

reginfo1002
registry creation error
%s1

Meaning of the message
The registry creation failed.

Meaning of parameters
%s1: Error details are displayed.

Type
Error

Treatment
Take actions according to the error details, and then execute the command again.

If this message is output repeatedly, collect the investigation data, and then contact a
Fujitsu system engineer.

reginfo1003
registry deletion error
%s1

Meaning of the message
The registry deletion failed.

Meaning of parameters
%s1: Error details are displayed.

Type
Error

Treatment
Take actions according to the error details, and then execute the command again.

If this message is output repeatedly, collect the investigation data, and then contact a
Fujitsu system engineer.
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